IKA

designed for scientists

HABITAT cell HABITAT cell vessel
HABITAT photo cell 0.25 L sw
HABITAT cell cct 0.25 L dw
HABITAT photo cell cct 0.5L sw
0.5 Ldw
1Lsw
1 Ldw
2 Lsw
2 Ldw
5L sw
5L dw
10 L dw

HABITAT ferment HABITAT ferment vessel
HABITAT photo ferment 0.25 L dw
HABITAT ferment cct 0.5Ldw
HABITAT photo ferment cct 1 L dw
2 Lsw
2 Ldw
5L sw
5Ldw
10 L dw
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Source language: German
EU Declaration of conformity

We declare under our sole responsibility that this product corresponds to the directives 2014/35/EU,
2006/42/EC, 2014/30/EU and 2011/65/EU and conforms with the following standards or
normative documents: EN 61010-1, EN 61010-2-051, EN 61326-1, EN 60529 and EN 1SO 12100.
Wireless module:

Directive: 2014/53/EU Standards: EN 60950-1, EN 300328, EN 301489-1, EN 301489-17

A copy of the complete Declaration of Conformity or further declarations of conformity can be
requested at sales@ika.com.

Note for USA (FCC)

This equipment complies with Part 15 of the FCC rules. Any changes or modifications not expressly

approved by the Manufacturer could void the user's authority to operate the equipment. This device

complies with Part 15 of the FCC rules subject to the following two conditions:

(1) This device may not cause harmful interference, and

(2) This device must accept all interference received, including interference that may cause unde-
sired operation.

NOTE:

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC Rules.

These limits are designed to provide reasonable protection against harmful interference when the
equipment is operated in a commercial environment.

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and
used in accordance with the instruction manual, may cause harmful interference to radio commu-
nications. Operation of this equipment in a residential area is likely to cause harmful interference in
which case the user will be required to correct the interference at his own expense.

Note for Canada (I1C)

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to

the following two conditions:

(1) This device may not cause interference

(2) This device must accept any interference, including interference that may cause undesired oper-
ation of the device.

This device complies with Health Canada’s Safety Code 6 / IC RSS-210. The installer of this device

should ensure that RF radiation is not emitted in excess of the Health Canada’s requirement.

Explication of warning symbols

/// Warning symbols

Danger! Indicates an (extremely) hazardous situation, which, if not avoided, will
result in death, serious injury.

Warning! Indicates g ha.za.rdous situation, which, if not avoided, can result in
death, serious injury.

Indicates a potentially hazardous situation, which, if not avoided, can
result in injury.

Notice! Indicates practices which, if not avoided, can result in equipment dam-
age.
Danger! Indicates the exposure to a hot surface.

Caution! Indicates crushing risk to fingers / hands.

/Il General Symbols

Position number
Indicates device components relevant to actions.

Correct / result
Indicates the correct execution or the result of an action step.

Wrong
Indicates the incorrect execution of an action step.

Note
Indicates steps of actions that require particular attention.

Closed lock
Indicates the status of “locked”.

Open lock
Indicates the status of “Unlocked”.

Safety instructions

/// General information

> Read the operating instructions completely before starting up and follow the
safety instructions.

> Keep the operating instructions in a place where it can be accessed by everyone. The
operating instructions are also available as a PDF or can be downloaded from the user
interface and also from the IKA homepage.

> Ensure that only trained staff work with the device.

> Follow the safety instructions, guidelines, occupational health and safety and accident
prevention regulations.

> The device must only be used in a technically perfect condition.

Notice!

> Pay attention to the marked sites in Fig. 1.




/// Device design

Caution!

»  The power switch of the device must be accessed immediately, directly and without risk at
any time. If access to the power switch cannot be ensured, an additional emergency stop
switch that can be easily accessed must be installed in the work area.

»  Ensure that your hands / fingers do not get crushed when setting down the device.

@ Caution!

»  Device surface is partially made of glass:
- Glass surface can be damaged by impact.
- If glass surface is damaged it could cause injury, don't use the device anymore.

Notice!

»  Set up the device in a spacious area on an even, stable, clean, non-slip, dry and fireproof surface.
> The feet of the device must be clean and undamaged.
> Ensure that the vessel stands safely on the device.

/I Working with the device

@ Danger!

» Do not use the device in explosive atmospheres, it is not EX-protected.

> With substances capable of forming an explosive mixture, appropriate safety measures must
be applied, e.g. working under a fume hood.

> To avoid body injury and property damage, observe the relevant safety and accident

prevention measures when processing hazardous materials.

Before use, the vessel system has to be cleaned and sterilized.

The device is not suitable for hand-held operation.

Do not touch the rotating parts during operation!

Autoclaving: 121 °C/ 25 ... 30 minutes

Do not close the hose jacket connectors for the temperature chamber of the double-wall

glass vessel while autoclaving! The vessel might get broken! Be aware of the hot surface after

autoclaving!

»  Turn off the peristaltic pumps before replacing any tubes or pump heads.

> During autoclaving, there must be no water in the condenser. Fill the condenser with water
only after autoclaving! For autoclaving remove the filling screw of the condenser.

@ Danger!

Working with gases:

- Gases can be hazardous to the health.

- Observe the general safety instructions for the handling of gases!

- Carry out regular training of personnel for the handling of gases.

- When connecting the supply lines, ensure correct connections and the maximum
permissible connection pressures!

- Only work with the original accessories, and check that they are in perfect condition
before operating the device!

- Close the gas supply at the end of the experiment.

- Determine the possible concentration of the escaping gases at the outlet of the bioreactor.

- Use all the necessary gases only in the quantities required, and make sure that the
atmosphere is not enriched with them.

- Ensure sufficient ventilation at the workplace.

- Observe the current safety data sheets for the gases used.

> Working with oxygen / Oz:

- As a compressed gas, oxygen is oxidising; aids intensive combustion; can react violently
with flammable materials.

- Observe the general safety instructions for the handling of gases (see above).

- The presence of oxygen reduces the ignition temperature and the necessary ignition

energy of a combustion and increases the fire temperature.

- Keep possible ignition sources (open flames, hot surfaces) away.

- Do not use oils or greases in the area containing oxygen (fittings, connections).

- Use oxygen only in the quantities required, and make sure that the atmosphere does not
become enriched with oxygen.

- Ensure sufficient ventilation at the workplace.

> Working with nitrogen / N2:

- Nitrogen is odorless and leads to asphyxiation in high concentrations!

- Observe the general safety instructions for the handling of gases (see above).

- Do not use oils or greases in the nitrogenous area (fittings, connections).

> Working with carbon dioxide / CO2

- Carbon dioxide is a non-flammable, acidic and colorless gas. High concentrations can be
fatal due to oxygen deficiency.

- Observe the general safety instructions for the handling of gases (see above).

- (CO2 is produced during fermentation processes, among other things. Pay particular
attention to good ventilation and connect the exhaust air duct of the bioreactor to a
suitable extraction device.

Keep this in mind when using larger quantities of CO2 for pH regulation.

. Warning!

Only process media that will not react dangerously to the extra energy produced through
processing. This also applies to any extra energy produced in other ways, e.g. through light
irradiation.

> Beware of hazards due to:
- flammable materials,
- glass breakage,
- overfilling of media,
- rotating parts.

> When handling hazardous substances or mixtures of substances which are toxic or
are contaminated with pathogenic micro-organisms, the user should take appropriate
precautions. Observe the national regulations, the biosafety level of your laboratory, the
material safety data sheets.

»  For germs or biological material or risk group Il or higher, please observe the “Laboratory
Biosafety Manual” issued by the World Heath Organization).

» It may be possible for wear debris from rotating accessory parts to reach the material being

processed.

The operation of a free rotating shaft end is prohibited.

Excessive or negative pressure can damage the glass reactor vessel.

Do not use damaged hoses.

Check all connections for leaks, especially all gas connections.

Caution!

> Wear your personal protective equipment in accordance with the hazard category of the
media to be processed. There may be a risk from:
- ejection of parts,
- release of toxic or combustible gases,
- splashing and evaporation of liquids,
- parts with hot surfaces.
» Stop operating if:
- the medium splashes out of the vessel because the speed is too high,
- the device is not running smoothly,
- the device begins to move around because of dynamic forces,
- an error occurs.

Notice!

> Remove the motor, the sensor cables and the foam sensor before autoclaving. Other parts are
autoclavable.
» Cover the sensor connections during autoclaving (for example with aluminum foil).



Covers or parts that can be removed from the device without tools must later be refitted to
ensure safe operation.

There may be electrostatic activity between the medium and the output shaft which could
cause a direct danger.

Never operate the device with the stirrer tools rotating freely. Ensure that parts of the body,
hair, jewelry or items of clothing cannot be trapped by the rotating parts.

Pay attention when setting the speed to any imbalance of the stirrer tools and possible
spraying of the medium to be stirred.

/// Accessories

>

Protect the device and accessories from bumping and impacting.

Check the device and accessories for damage before each use. Do not use damaged com-
ponents.

Safe operation is guaranteed only with the use of original IKA accessories.

Ensure that the external temperature sensor is inserted into the medium to a depth of at
least 20 mm when connected.

Observe the operating instructions of the accessories.

/Il Power supply / Switching off the device
Warning!

>

After a power failure during operation, the device may start automatically (depending on the
operating mode).

Restart PC/ App and the IKA HABITAT software if a software failure occurs. IKA HABITAT will
run without an active connection with PC/ App.

The voltage stated on the type plate must correspond to the mains voltage.

The device can only be disconnected from the power supply by pulling out the mains plug
or the connector plug.

The device must only be operated with the original power cord set.

The socket for the power cord must be easily accessible.

Socket must be earthed (protective ground contact).

Replace the fuses only after disconnecting the device from the power supply by pulling out
the mains plug. The fuse value must correspond to the value on the serial license plate.

/// Maintenance

>

The device may only be opened by qualified and approved experts. The device must be
unplugged from the power supply before opening. Live parts inside the device may still be
live for some time after unplugging from the power supply.

Only use original IKA spare parts!

/// Disposal instructions

>

The device, accessories and packaging must be disposed of in accordance with local and
national regulations.

Intended use

/// Use

>

Bioreactors are designed to run cell growth or fermentation processes.

/// Area of use

> Indoor environments similar to that a laboratory of research, teaching, trade or industry area.
> The safety of the user cannot be guaranteed:

if the device is operated with accessories that are not supplied or recommended by the
manufacturer,

if the device is operated improperly or contrary to the manufacture’s specifications,

if the device or the printed circuit board are modified by third parties.

Unpacking
&5

/// Unpacking

» Unpack the device carefully. Any damage should immediately be reported to the carrier (mail,
rail or freight forwarding company).

/11 Scope of delivery

o

1 HABITAT cell / ferment 5 LAN cable 1 m
2 Tablet PC 6 USB-C Adapter
3 Power cord set H 11 7 User guide

4 USB-C to Ethernet Adapter 8 Warranty card




[@ For ferment only

@ For SW 2&5 L ferment only]

3

Note.

HA.vh.x vessel holder incl. HA.lc.x lid
mounted

HA.gv.sw.x (vessel single wall) or HA.gv.dw
(vessel double wall)

HA.mt.s.x (Motor)

HA.sp.m.x (Micro sparger) or HA.sp.r.x* (Ring
sparger)

HA.cn

HA.cn.flx

HA.ip.pi.x (Impeller 3-pitch blade) or
HA.ip.b.x* (Impeller 6 blade) (for vessel size
5/10L, 2%)

HA.s.tm.x (Temperature sensor)

HA.s.ph.x (pH sensor)

HA.s.do.x (DO sensor)

HA.s.fo (Foam sensor)

HA.hbl.x (Heat blanket)

HA.cab.sw (cable set for single wall) or
HA.cab.dw (cable set for double wall)

HA.sf.250 (Bottle 250 ml x4)

HA.sam (Syringe set)

HA.cf.x (Cooling finger)**

Tool set

HA.ba.x* (Baffle, not available for 0.25 L)

: "x" refers to the number of the vessel size like 0.5,
Abbreviations:
sw: single wall
aw: double wall

HA.cn is used for:
cell / ferment sw / dw 0.25 L
cell / ferment sw / dw 0.5 L
cell / ferment sw/ dw 1 L
cell/sw/dw 2L

HA.cn.flx is used for:

cell / ferment sw / dw 5 L
cell / ferment dw 10 L
ferment sw/dw 2 L

1,2,50r10,e.9. 2L« HA.gvsw.2; 0.5 L « HA.gv.sw.0.5.



Filter (2x)

Filter heater

Plug in barb connector 6 mm x 5 mm (8x)

Hose reducer 6.4 mm x 3.9 mm (2x)

Y hose connector 3.2 mm (3x)

Silicone tube 3.2 mm x 6.4 mm x 7.5 m

Silicone tube 4.8 mm x 9.5mm x 3 m

Y hose connector 4.8 mm (3x)

PUN tube OD 6 mm x 10 m

Filter (4x)

pH cable

DO cable

USB cable

RS 232 cable

Hose clamp (5x)

Silicone cap:
ID 3.5mm x 25.4 mm (10x)

ID 13.6 mm x 38 mm (2x)

Twist tie (10x)

Hose with GL18 and quick coupling (2x)

Silicone tube 8 mm x 12.7. mm x5 m

Hose clamp (4x)

Useful information

The HABITAT is operated with an iOS Tablet PC (included in the scope of delivery).
Alternatively, the operation is also available via an MS-Windows® PC / notebook.

Wired and wireless operation is supported. Monitoring is also available for an iOS mobile
system by means of the Bioreactor App.

During the process, the Tablet PC or notebook can be decoupled from the device. The device
works independently of the user interface software. All data is stored in the device.

The status of the main device parameters is indicated by a LED bar. (see "Alarm setting")
Green LED: ok, within the limit values

Orange LED: not ok, out of the limit values

Red LED: not ok, an error has occurred

When the Tablet PC / notebook is reconnected, all data from the device is transferred to the
software of the Tablet PC / notebook and displayed.

Safe-STOP button: Immediately pause all actuators (Stirrer, Heater, Pumps, MFCs / Mass-
flow Controllers, Thermostat, Light panel).

Safe-STOP: Press the button at the control unit / or the button on GUI. All actuators stop.
Exit Safe-STOP: Press the button on the control unit again (not in the software). All actu-
ators are switched on again according to the settings.

Mains switch: Switch on / off the device

Power-ON: Control unit on, ready to start

Power-OFF: Control unit off, no power supply

(N o e
Stirrer Temp pH

Gl GEN
pO2 Level Foam

Mains switch

Notice!

>

The data log file is only active after the "Experiment" has been started. After pressing the
"Play" menu button in the software, all data from "Start" to "Stop" are recorded. An experi-
ment can only be created with a a single name.

In safe-STOP mode, the data will continue to be recorded. The log file shows that all actu-
ators have been stopped for the duration of the safe-STOP.



Installation /// Interfaces

/// Gas

Max. 1.0 barg
Barb 5 mm

Max. 3.0 barg
Tube OD 6 mm
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USB USB connection (data storage)

PC PC connection (communication with GUI software)
RS-232 RS 232 connection (communication with GUI software)
ETHERNET Ethernet connection (communication with GUI software)
SU-CONNECT Sensor connection SU Vessel

LIGHT Light panel connection

THERMOSTAT Thermostat connection

EXT. PUMP External pump connection

EXT. SIGNAL Connection 4....20 mA

PELTIER Peltier cooling connection

FILTER HEATER

Filter heater connection

HEAT BLANKET

Heat blanket connection

STIRRER

Stirrer connection

POWER SOCKET

Power supply connection

FUSE SOCKET

Position of fuses




/// Vessel

Single-wall
glass vessel

Y

(]

0.25L
Double-wall
glass vessel 0.25L

/1 Lid

Port sizes
Ports

0.251L 05L 1L 2L 5L 0L
Temp 4 mm M10
DO

Level Pg13.5
Baffle

pH

Pg13.5
M12

11 mm
Pg13.5

Exhaust cooler M16

Harvest 4 mm M10

Sparger 11 mm

Feed barb 5 mm (x3) | 11 mm (x2)
4in1/Feed

M27

Cooling finger M27

Inoculation 11 mm (x1) 11 mm (x1) 11 mm (x1)

11 mm (x1)
x1
Reserve Pg13.5

(if level not in use) B K 2 = x4

Reserve 11 mm

x1 x1
Reserve M27

x1 X2

x1

0.25L 05L

cotene O O
—e O
Spanger O

1L 2L

Condensar

/
/' inoculation O

- QO Battis
—o O o-
‘ Sparger O

20 e

4in1/Feed

Condsnser

O
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/// Harvest pipe

/// Lid with plugs and fittings

10 mm
10 mm
10 mm

10 mm
3.2mm

/// Drive shaft

/// Ring or micro sparger

21

o

/Il Impeller

20



/// Temperature sensor

/// Level sensor

/// Baffle

/// Condenser

@ Danger!

/I1 DO, pH, CO,, conductivity or turbidity probe

Caution!

» During autoclaving, there must be no water in the condenser. Fill the condenser with water

Notice!

only after autoclaving! For autoclaving remove the filling screw of the condenser.

» Related on the lid size the ports may vary!

» Read the operating instructions for the

probes carefully!

4. Turn
M

23
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/1 Spin filter (accessories) /// Vessel and stand

/—‘—%
HA fi.x
(accessories)

/// Lid and vessel
Notice!

» Check the presence of the lid sealing. Never work without the lid seal. Risk of glass breakage.
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/// Peltier cooling

Notice!

» The Peltier cooling may only be used in conjunction with the IKA HABITAT.

/// Foam sensor

> Blue LED ON: Good alignment between sensor boxes, and no foam present.
> Blue LED OFF: Poor alignment between sensor boxes, or with obstructions in LED field of view.

p —
HA.cn (for Cell / Ferment 0.25 L, 0.5L, 1 L& Cell 2 L)

<=5 HA.cn.flx
; (for Cell / Ferment 5 L,
10 L & Ferment 2 L)

Refer to the
assembly instructions
of HA.cn flx.

Cable connection

Control tower

n‘mmzm]l!l;

\

27



28

/// Heat blanket
Warning!

» Ensure that the electrical equipment is in good condition before use.
» For a long service life: Do not cut or fold!

» Store the heat blanket in a flat condition.

» Only for the use with single-walled reactor vessels!

/l] Twist tie

/// Pump tubing

> Flow rate
Tube ID Howrate fecmin) Pump head adjustment
min max
0.5 mm 03 4 (A
0.8 mm 1.0 12 (A
1.2 mm 1.6 20 (A
1.6 mm 3.0 45 (A
2.4mm 7.0 85 (B
3.2mm 13.3 140 (B
4.8mm 26.6 270 (B

>

>

Adjust the pump head

29
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/Il HA.ep External peristaltic pump (accessories)

»  Refer to the operating instructions of HA.ep.

/// Connecting gas outlet to sparger

[ Connecting gas outlet to sparger: with barb connector }

/// Hose connecting

»  Keep the hose connection as short as possible.

Flask stand
(HA.sfr.250, accessories)

O 2

~ | "Hose reducer @?
6.4 mm x3.9mm %

="

' Silicone tube Oe %

14.8mmx9.5mmx3m @j

'PUN tube @; PON,

,,,,,,,,,,,,,,,,, |
|
|

o,

ES\Iicone tube O —
148mmx9.5mmx3m (3),

31



//l Schematic view - 4 gases system /// Lid stand (accessories)

> Refer to the operating instructions of HA.Is.2 and HA.Is.10 plus.

[4 gases system / IKA HABITAT Cell growth & Ferment ]

Abbreviation  Description Abbreviation  Description

FS Flow Sensor pH pH Sensor
- . = FTTTTTTTTTT e T 7 N
(@Y Check Valve Level Level Sensor While not in use | |
| |
FvC Flow Control Valve Temp Temperature Sensor | |
| |
PRV Pressure Relief Valve CO2* CO2 Sensor : :
F Filter Cond* Conductivity Sensor : %a :

=

FM Foam Sensor Turb* Turbidity Sensor : @ :
| |
HBL Heat Blanket FH Filter Heater | |
| |
pO2 DO Sensor | 1
HA.Is.2 or 'HA.Is.10 plus !
|
|
|
|
|
|
|
|
I

** Cell growth 0...2000 ccm
Ferment 0...20000 ccm o
A
Air 3 bar max FS CV, PRV -
0..2000 cem** FVC 1 par
|
N2 3 bar max){ ES v = PRV i
0..2000 ccm** 1 bar

02 3 bar maxy~{ FS &% PRV ¥ ° LFHJ

PV LLLL]

0..2000 cem* C g = —

=Y

€023 barma>-{ _FS V) PRV M
FVC
0...2000 ccm**

Pump Acid C}
Pump Base C}
Pump Foam @
Pump Level C> v

— o T
-
— w T
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Operation

/11 Switching on / off

1.Turn on the device by using the mains switch on the control unit.
2.Start tablet PC / laptop Bioreactor App.
3.Connect tablet PC / laptop via Ethernet, Wi-Fi® or Serial port.

/// HABITAT "Quick start Guide"

1.i0S Installation

1.1 iPad Setup

» Set up your device for the first time or after having done a factory reset.

» For the setup of the iOs device (Apple iPad) please refer to the device setup information from
Apple Inc.

1.2 Installing the HABITAT app
» Go to the App Store and search for "IKA HABITAT" or scan the QR code below to install the

app.

Filters v Q ika habitat

IKA HABITAT

IKA THE ERGONOMIC BIOREACTOR

KA HABITAT wenaris = gar—— - d

App Store

e8
Iy
i

s
i

()

L]
¥
s

» Click the link on your iOS device to install IKA HABITAT app
(https://apps.apple.com/us/app/ika-habitat/id1579608969)

H
y
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W

!‘::.';if, ?
y
- ’!.. -
!:ii
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1.3 Updating the application / app

» If an update of the IKA HABITAT app is available in the App Store, you will be notified.
Note: If the IKA HABITAT app was installed by a previous user or already in the delivery state,
the app must first be uninstalled and reloaded when changing accounts.

2. Getting start

2.1 Initial commissioning and setup

First, turn on the IKA HABITAT, make sure that the device is ready for operation (all LEDs:
green) and connected to the computer / Tablet PC via Wi-Fi® or Serial connection / USB cable.
.1.1 Connecting to the device (See "HABITAT Software connect Guide")

N

N

.2 Logging in

After initialization and synchronization between the operating software and the control unit,
the opening screen shows the process view (main screen with reactor vessel and all process
parameters and status).

The user must log in to operate the device. The default user name and password is “admin”.
The password can be changed after the first login.

N

.3 Setting the set points

After clicking on a parameter values

window, a submenu for setup and control

settings appears.

.3.1 Operating mode

The user can select and set the operating Set flow (ce/min):

mode for each component / controller:

- Off: Component / controller is off.

- Manual: Component / controller
operates according to the user's setpoint
settings

- Automatic: Component / controller
operates according to the control
algorithms of the process conditions.

- Profile: Component / controller
operates according to predefined set
points.

Air Control

Mode:

N

Cancel

2.4 Changing "User ID" and "Password" 2.5 Time synchronization

» Login. » After clicking the menu "Device time", a
» Click the icon "User" and then the submenu submenu opens with a confirmation dialog

“User Management”. for time synchronization between the Tab-
» In the "User Management" menu, click let/PC and the control unit.

"Edit user", and then enter your new pass-
word.

Device time

Admin

Logout

User Management%

Quit

2.6 Exit the application
» Click on the icon "User" followed by "Quit”.


https://apps.apple.com/us/app/ika-habitat/id1579608969
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/// HABITAT "Software connect Guide"

1.Software connection (Windows version)

1.1 Components

> HABITAT control unit

» Laptop / PC with HABITAT software installed

> Cable (USB, RS-232, LAN) or Wireless (Wi-Fi®) connection

1.2 Connection (4 options)
1.2.1 USB cable connection

usB

&

(]

&)

G

&

ee=en ==

» Open the IKA HABITAT software and select "Scan for new Device".
- The software shows the available devices detected from the serial port.
- Click “Connect” to start the connection.

Available Devices Available Devices

IKA HABITAT (300010000)

Interface: Serial
COM port: COM10

Connect

IKA Habitat_49162C1CDAC (N/A)

1.2.2 RS-232 cable connection

» Open the IKA HABITAT software and select “Scan for new Device".
- The software shows the available devices detected from the COM port.
- Click "Connect" to start the connection.
Available Devices Available Devices
IKA HABITAT (300010000) (KA HABITAT (300010000)

nter manual i "
IKA Habitat_49162C1CDAC (N/A) Interface; Serial
COM port: COM7

|KA Habitat 49162C1C3ES (N/A) v Connect

IKA Habitat 49162C1CDAC (N/A)

- After data synchronization, the icon "Cable connection” is displayed.

Ly
You are not logged in 0 m

1.2.3 Ethernet / LAN cable connection

Same network

Ethernet Ethernet

Open the IKA HABITAT software and select "Scan for new Device".

m)
-]
[ ]
®

D

- The software shows the available devices detected from the Ethernet port.

- Click "Connect" to start the connection.

Available Devices Available Devices

IKA Habitat 49162C1CDAC (N/A) IKA Habitat 49162C1294E (N/A)
KA HABITAT (300010000) IKA Habitat 49162C1CDAC (N/A)
IKA HABITAT (300010000)

Interface: Ethernet
IP address: ::ffff:192.168.56.63

Connect

- After data synchronization, the icon "LAN cable connection” is displayed.

- o x|

You are notlogged in

1.2.4 Wi-Fi® connection
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» Open the IKA HABITAT software and select “Scan for new Device".
- The software shows the available devices detected from the Wi-Fi® SSID:
IKA_HABITAT _XXXXXXXX
- Click "Connect" and enter the Wi-Fi® password “ikahabitat” (only necessary for the first
connection) to start the connection.

Available Devices Available Devices

IKA Habitat 49162C1CDAC (N/A)

IKA Habitat_49162C1294E (N/A)

|KA Habitat_49162C1CDAC (N/A) _

IKA Habitat 49162C1294E (N/A)

Interface: Wi-Fi
IP address: 192.168.10.250

IKA HABITAT (300010000) St

Forget Network Connect

- After data synchronization, the icon "Wi-Fi® connection" is displayed.

Available Devices

|KA Habitat 49162C1CDAC (N/A)

|KA Habitat 49162C1294E (N/A)

Enter the network security key

2.App connection (i0S version)

2.1 Components

» HABITAT control unit

» iPad with HABITAT App installed (download from App store)
> Wi-Fi® connection

2.2 Connection
Wi-Fi® connection from iPad to the control unit

» Enter the password “000000” (default password for logging in).
» Open the IKA HABITAT App and select “"Connect to Wi-Fi®... ".

Available Devices

Scan for new Device...

Enter manually.

Connect to Wi

detected

Scan for new Device...

Enter manually...

» Select "Wi-Fi®" setting.

< Habitat 12:51 Wed 18 May

Settings
-) GD

Apple ID, iCloud, Media & Purchases

iPad Not Backed Up o

Airplane Mode
Wi-Fi Robotics@IKA

Bluetooth On

> Connect to the HABITAT control unit via Wi-Fi® SSID: IKA_HABITAT _XXXXXXXX-
- Enter the password “ikahabitat” (only necessary for the first connection) to start the connection.
4 Habitat 12:51 Wed 18 May 7% (%)

Wi-Fi
Settings Wi «©

IKA Habitat_49162C19514 e
Apple ID, iCloud, Media & Purchases

MY NETWORKS

ipad Not Backed Up o Robotics@IKA YO
Airplane Mode Enter the password for “IKA Habitat_49162C19514"
= Wi-Fi IKA Habitat_49162C19514 a &= @
Cancel Enter Password Join
Bluetooth on 8 =0
hc

i Password :]
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Settings

» Click to return to the IKA HABITAT App.

< Habitat 12:51 Wed 18 May

Apple ID, iCloud, Media & Purchases

iPad Not Backed Up

. Airplane Mode

= Wi

Bluetooth

Wi-Fi
Wi-Fi

IKA Habitat_49162C19514

No Internet Connection

MY NETWORKS

Robotics@IKA

NETWORKS

i IKA Habitat_49162C19514

On

» Select "Scan for new Device".

Haydale_lab

Haydale_lab_5G

- The software shows the available devices detected from Wi-Fi®.
- Click "Connect" to start the connection.

Available Devices

Scan for new Device.

Enter manually..

Scan for new Device

Enter manually...

Connect to Wi-Fi...

ected

Available Devices

Unidentified Habitat device (N/A)

Interface: Wi-Fi
IP address: 192.168.10.250

Connect

- After data synchronization, the icon "Wi-Fi® connection" is displayed.

IMPORTANT NOTE!
- Disable "Auto-join" for Wi-Fi® connection to other devices to establish a stable connection

between iPad and Cont

Settings
Sign in to your iPad
Set up iCloud, the App Store
and more.

Apple TV+ Free for 3 Months

Apple Arcade Free for 3 Months

Airplane Mode
Wi-Fi Robotics-5G@IKA

Bluetooth On

rol Unit.

Wi-Fi

/ Robotics-5G@IKA
Weak Security

MY NETWORKS

IKA Habitat_49162C1294E

IKA Habitat_49162C19CEB

OTHER NETWORKS 3,

Bun

Haydale_lab

Wi-Fi

P)
® ©

®
P)

>
P)

P)
® ©

Settings

Signin to your iPad
Set upiCloud, the App Store
and more.

Apple TV+ Free for 3 Months

Apple Arcade Free for 3 Months

Airplane Mode
= Wi-Fi Robotics-5G@IKA

Bluetooth on

< Wi-Fi Robotics-5G@IKA

Weak Security
WPA/WPA2 (TKIP) is not considered secure.

If this is your Wi-Fi network, configure the router to use WPA2 (AES) or WPA3
security type.

Learn more about recommended settings for Wi-Fi.

Forget This Network

Auto-Join ] @
Private Address C

- Enable the "Auto-join" only for pairing with the controller unit to establish a

stable connection between iPad and control unit.

Settings
Sign in to your iPad
Set up iCloud, the App Store
and more,
Apple TV+ Free for 3 Months

Apple Arcade Free for 3 Months

Airplane Mode

Wi-Fi IKA Hal

_49162C19CEB

Bluetooth on

Settings
Sign in to your iPad
Set up iCloud, the App Store
and more,
Apple TV+ Free for 3 Months

Apple Arcade Free for 3 Months

Airplane Mode

Wi-Fi IKA

tat_49162C19CEB

Bluetooth on

3 notifications

Wi-Fi
WiFi O
v ‘rﬁHab‘itwa(_ﬁg.16,201BCEB a
MY NETWORKS
IKA Habitat_49162C1294E a =0
Robotics-5G@IKA a0
OTHER NETWORKS ¢
Bun a0
Haydale_lab 8 =0
HaydaleAIS_QC a =0
< Wi-Fi IKA Habitat_49162C19CEB

No Internet Connection

If this is your Wi-Fi network, try restarting the modem and the router, or contact
your ISP.

Weak Security
WPA/WPA?2 (TKIP) is not considered secure.

If this is your Wi-Fi network, configure the router to use WPA2 (AES) or WPA3
security type.

Learn more about recommended settings for Wi-Fi.

Forget This Network

—

Auto-Join

@

«©
Private Address O
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2.3 iPad cable connection
» Backup solution for cable connection from iPad to the control unit

2.31 Components
(D USB-C to Ethernet Adapter (with the charging port)
) LAN cable

2.32 Connection
» Connect the iPad to the Ethernet Adapter.

» Connect the charging port of the control unit to the “USB-C” port of the Ethernet Adapter.
» Connect the Ethernet port of the control unit to the “Ethernet” port of the Ethernet Adapter.

Ethernet Adapter USB port

—

> Set Ethernet connection for iPad (one-time setting):
(D Select "<...> Ethernet"
(2) Select "USB 10/100 LAN"

Ethernet

Settings

Q search USB10/100LAN | @)

) D
Apple ID, iCloud, Media
& Purchases

Update Apple ID Settings ﬂ

INTERFACES

Finish Setting Up Your iPad °

Airplane Mode
Wi-Fi off

I o

Bluetooth On

() Select “Configure IP”

£ Ethernet USB 10/100 LAN

Settings

as & Limit IP Address Tracking
earc

«©

Limit IP address tracking by hiding your IP address from known trackers in Mail and Safari

Apple ID, iCloud, Media
& Purchases Configure IP 9

Update Apple ID Settings (1) IP Address
Subnet Mask
Finish Setting Up Your iPad 0 Router
Airplane Mode oS
. Configure DNS
Wi-Fi off
Bluetooth on Configure Proxy

Manual

192.168.10.10

255.255.255.0

192.168.10.251

Automatic

off
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@) Select “Manual”

) Set the IP Address / Subnet Mask / Router:
IP Address: 192.168.10.10
Subnet Mask: 255.255.255.0
Router: 192.168.10.251

) “Save” the setting

& USB10/100 LAN Configure IPva (6]
o
settll‘lgs Automatic
Q seareh 9 J
G
.
a Apple ID, iCloud, Media
& Purchases MANUAL 1P
Update Apple ID Settings (1) IP Address 192.168.10.10
Subnet Mask 256.255.255.0
Finish Setting Up Your iPad
inish Setting Up Your iPad @ Router 192.168.10.251
cc 8
1 2 3 4 5 6 7 8 9 0 &

» HABITAT software connect
(1) Open HABITAT software
elect "..." at "Device Connection"
elect "Enter manually"
elect communication type as "Ethernet”
efine host name as "192.168.10.251"
efine port as "40999"
) Then, click "Connect”
- After data synchronization, the icon "Ethernet connection" is displayed.

You are not logged in

Device Connection

o Scan for new Device...
Communication Type

L [eermonaly.

Host name Connect to Wi-Fi...

Antifoam

Connect

-- Skip Connection -

IKA HABITAT Vversion0.143 o / You are not logged in

Device Connection

Communication Type

B - ©

Host name

Port

Connect @

-- Skip Connection -

Admin @ ]

3.HABITAT App connect (Android version)
3.1 Components
> HABITAT control unit

> Android Tablet with HABITAT App installed (download from Play store)
> WI-Fi® connection

3.2 Connection
Wi-Fi® connection from Tablet to the control unit
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» Open HABITAT App, and select "Connect to Wi-Fi®...". » Click to return to the IKA HABITAT App.

Available Devices

Scan for new Device

A software update is available

Enter manuall

Connect to Wi-Fi Later Open
Current network
Q
= |KAHabitat_49162C19514
g ; "®  Connected without intemet
amsung accoun
No devices detected Profile - :uu?\y . Anpsu e Available networks
IWT-GUEST
Auto reconnect turned off
. o Connections
> Connect to the HABITAT control unit via Wi-Fi® SSID: IKA_HABITAT_XXXXXXXX WHE] - Blustooth  Alrplane moda % Robotics@IKA
- Enter the password “ikahabitat” (only necessary for the first connection) to start the
connection. Sound % Haydale_lab

| Sound mode - Ringtone
- Recommend to select "Always connect” (only necessary for the first connection). _
Notifications 5 IWTIKA

Status bar + Do not disturb
s Robotics-5G@IKA

A software update is available

Later Open

Display
Brightnes: — Id - Navigation bar HaydaleAIS_Lab

Current network

2 |KAHabitat_49162C19514

i Connected without intemet
Samsung account e

Profile + Security + Apps

» Select "Scan for new Device...".
WraUEST - The software shows the available devices detected from Wi-Fi®.
Autorsconnsct tumed off - Click "Connect" to start the connection.

Available networks

Connections
WiFi + Bluetooth - Airplane mode
Robotics@IKA

Available Devices s

Unidentified Habitat device (N/A)

Enter man

‘ Available Devices
Sound o Haydale_lab
nd mode - Ringtone Unidentified Habitat device (N/A)
Notifications = IWT-IKA

Status bar + Do not disturb

Interface: Wi-Fi
IP address: 192.168.10.250

Robotics-5G@IKA

Connect
Display

Brightness - Eye comfortshield - Navigation bar > HaydaleAIS_Lab

0 - After data synchronization, the icon "Wi-Fi® connection" is displayed.

q =
You are not logged in 9 o

< IKA Habitat_49162C19514

Auto reconnect




IMPORTANT NOTE! /// Menu structure
» Disable "Auto-join" for Wi-Fi® connection to other devices to establish a stable connection

between Tablet and Control Unit Available —_ Scan for new

5@ < Device - W
- Enter manually — Communication —Wi-Fi —’: Host name
Type Port

Settings =

Etherne Host name
Cument network
Port

Robotics@IKA

Samsung account Serial
= < Aowe Available natw

IKA Habitat_49162C19514
Auto reconnect tumed off ~
. Connections L Cc
WiFi + Bluetooth - Aiplane mode IWT-GUEST

Auto econnect tumed off

3audrate

Rngtone b anatisaczate Main Screen User menu Login/Logout ——Username
Notifications C ‘ e
e ‘e D : b % Haydale_lab

— Device time Quit
IKA Habitat_49162C19CEB

@ Dispey

Brightness - Eyec * Navigation bar

IWT-KA

—

Name

System colo
mn

L Username
- Status bar Email address
Robotics@IKA

- Safe-stop

(7 Network speed 72 Mbps

[ WPA/WPAZ-Personal ‘

Auto reconnect

Manage router L
— List view Edit user ‘r
| Email address
» Enable the "Auto-join" only for pairing with the controller unit to establish a stable connec- Trend Password
N = end view L asswo
tion between Tablet and Control Unit. Con
~ contirm ord
r Historical data - User en
Settings ‘ ~ User role Monitor
PR — - Alarm — Operator
a2 IKA Habitat_49162C1294E ;\—{‘“m
Avallable networks " Maintenance L Password never expire

IKA Habitat_49162C19514
Auto reconnect tumed ot
Connections.
Wifi - Bluetooth - Aiplane mode

IWT-GUEST r

Auto econnect wmed o

ngs

@ sound = Robotics@IKA

dmode - Ringtone Auto econnect tumed o L

nfo

Haydale_lab

IKA Habitat_49162C19CEB

e - Navigaton bar

IWTIKA

IKA Habitat_491

=

Connected without internet

Auto reconnect

Manage router
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Process view —

— Batch Batch ID
information Name
Recipe
Status
Elapsed Time
Note
i Start Button —— Start Cultivation —— Entering batch name
Entering note / comment
Choose recipe
Initialize batch
Start cultivation
Cancel
- Air/02/N2/CO2 Mode Off
Manual
Cascade - DO control
Profile Loop mode Stop
Set flow Continue with
last setpoint
Repeat the loop
Start profile
Edit setpoint
Add setpoint
Insert setpoint
Delete setpoint
- Acid/Base — Mode Off
Manual
Auto - pH control
Profile Loop mode Stop
Continue with
last setpoint
Repeat the loop
Start profile
Edit setpoint
Add setpoint
Insert setpoint
Delete setpoint
r Set flow
I~ Set volume
I~ Rotation Clockwise
Counterclockwise
— Calibration Calibrate 4[ Tubing ID
information <\: Set volume
Filling Tubing ID
T Tubing length
I Anti-foam Mode Off
- Manual
[~ Auto - Foam limit
- Profile Loop mode Stop
Continue with
last setpoint
Repeat the loop
Start profile
Edit setpoint
Add setpoint
Insert setpoint
Delete setpoint
(- Cascade-DO (Lower Active)
+ Cascade-DO (Over Active)
- Biomass Feed (Lower Active)
- Biomass Feed (Over Active)
& Exponential feed
- Set flow
- Set volume

I Rotation Clockwise
Counterclockwise

= Calibration Calibrate T Tubing ID
information Set volume

Filling *\:Tubing ID
Tubing length

— Feed Mode Off
- Manual
i Auto - Level limit
- Profile Loop mode Stop
Continue with
last setpoint
Repeat the loop
Start profile
Edit setpoint
Add setpoint
Insert setpoint
Delete setpoint
t RQ Feeding (Lower Active)
| Gravimetric
i~ Profile Gravimetric
- Profile Flowrate
+ Exponential feed
- RQ Feeding (Over Active)
F pH Feeding (Lower Active)
- pH Feeding (Over Active)
i Cascade DO (Lower Active)
= Cascade DO (Over Active)
r Set flow
- Set volume
- Rotation Clockwise
Counterclockwise
- Calibration Calibrate Tubing ID
information T 4[ Set volume
Filling *\: Tubing ID
Tubing length
I~ Stirrer Mode Off
 Manual
i~ Cascade - DO control
- Profile Loop mode Stop
Continue with
last setpoint
Repeat the loop
Start profile
Edit setpoint
Add setpoint
Insert setpoint
Delete setpoint
= Chaotic mixing —[ Speed range in Chaotic mixing
Duration to run Chaotic mixing
L Set speed
= Rotation Clockwise
Counterclockwise
r Exhaust Mode Off
Auto
- Filter Heater
— Peltier Off/On
Foam limit — Mode 4[ Off
Auto
i On delay
~ On time
- Sensitivity

— Double detection with level probe
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r Level limit Mode Off
Auto
On delay
On time
Sensitivity
Level control —[ Harvest
mode Feed
— Temperature — Mode Off
EAuto
Profile Loop mode Stop
Continue with
last setpoint
Repeat the loop
Start profile
Edit setpoint
Add setpoint
- Set Temp. Insert setpoint
t Set value offset Delete setpoint
= Actuator T Heating blanket
Thermostat
r pH Mode Off
EAuto
Profile Loop mode Stop
Continue with
last setpoint
Repeat the loop
Start profile
Edit setpoint
Add setpoint
[~ Set Temp. Insert setpoint
I Set value offset Delete setpoint
= Digital sensor enable
~pO2 Mode Off
Manual Output
Auto *[ Set pO2
Offset
Profile Loop mode Stop
Continue with
last setpoint
Repeat the loop
Start profile
Edit setpoint
Add setpoint
Insert setpoint
Delete setpoint
- Digital sensor enable
- Light panel —— Mode Off
{ Manual
Auto *[Tum on time
Turn off time
r Actuator 4[ White color
RGB color
& Color adjustment

- Sample Data Sample Label
—[ Sample Note

Setup view — General —— Batch mode Batch
—{ Fed-batch
Perfusion
i~ Select logging 5 sec
interval 10 sec
30 sec
1 min
5 min
15 min
30 min
- Select savin Internal
location ’ ‘[ usB
~ Note
 Reactor Vessel Single wall 0.5 L Glass
- Single wall 1 L Glass
[~ Single wall 2 L Glass
- Single wall 5 L Glass
- Mobius® 3L SU
2 Loptic SU
- Double wall 0.5 L Glass
- Double wall 1 L Glass
 Double wall 2 L Glass
- Double wall 5 L Glass
- Double wall 10 L Glass
r Single wall 0.25L Glass
- Double wall 0.25L Glass
- Sparger *[ Ring sparger
Micro sparger
- Propeller 6-blades disc
E}blades disc
Paddle stirrer
—No. of propeller —- 0
1
2
3
r Filter 50 mm, 0.22 Micron
ESO mm, 0.45 Micron
50 mm, 1.0 Micron
+ Spinfilter 10 pm
20 pm
40 pm
75 um
- Baffles
r Harvest pipe
- Cooling finger
r Pumps Pump A Acid
~ Pump B Base
+ Pump C Anti-foam
- Pump D Feed/Level
= Pump ExtA
r Gases — Air
r 02
N2
r CO2
= Gas Mixer for mixing Air and O2
- Controllers — pO2 Cascading to Stirrer
Cascading to Air
Cascading to Oz
Cascading to N2

Cascade setting —E+

Apply
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,pH

Select output
path for Air T
Select output
path for O2 —E

Select output
path for N2 —E

Cascading to Acid
Cascading to Base
Cascading to CO2

Select output
path for CO2 —E

r Cell & Medium 1 Cell information - Name
information Lot Number
Description
- Culture medium 1 Name
Lot Number
Description
- Process Name
supplement E Lot Number
Description
- Accessories & — Light Panel
Option - COz sensor
 Conductivity sensor
~ Turbidity sensor
I~ Ext-A signal
[~ Ext-B signal
- BlueVary
+ CgqgBior
I Weight Sensor
- Redox Sensor
- Incyte Sensor
L Excell Sensor
- Load Recipes Filter option
Filter keyworrE
Load
Close
- Save ——— Save recipe Filter keyword
T Save
Cancel
= Clear

Overlay
Sparger
Overlay & Sparger
Overlay
Sparger
Overlay & Sparger
Overlay
Sparger
Overlay & Sparger

Overlay
Sparger
Overlay & Sparger

Any column
Name column
Author column

List view —— Temperature Name
 pH Actual value
- pO2 Set value
- Exhaust Unit
- Stirrer Mode
= Air Alarm enabled
r 02 Alarm status
N2 Error
- CO2
~ Acid
- Base
r Anti-foam
i Level
- Subs
I Foam limit
- Level limit
- CO2 probe
- Conductivity probe
- Turbidity probe
L Light panel
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Trend view — Trend settings — Enable

t Plot Color
- Auto scaling
~ Min Y-Axis
= Max Y-Axis
rZoom in
- Zoom out
- Sync
- Export Data —[ Export to CSV
Save to USB

56

- Plot Parameter —- Stirrer

 Temp

FpH

- pO2

 Acid

i~ Base
 Anti-foam
I Level

- Air

02

~ N2

- CO2

- Light

- CO2 probe
- Cond.

- Turb.

- BV_M1

- BV_M2

- BV_Pressure
~ BV_Humidity
- CgagBior

~ BV_OUR

- BV_CER

r BV_RQ

F Weight

- Redox

r Incyte_VCD
I Incyte_COND
t Excell_AU

L Excell_OD

Historical data Preview
Export to CSV
Generate report
Save to USB

Search *[ Filter Keyword

Filter in Any column
Name column
Operator column
Start date column
Status column

Alarm ——— #

- Timestamp
 Error code
 Description
= Value

Mantenance —- Sensor — Temp — Last Calibration

Calibration L Serial no.

~ Zero
- Slope
i Condition
L Action — CAL
- pH —— Last Calibration
- Serial no.
- Zero
~ Slope
r Condition
= Action — CAL
= pO2 —— Last Calibration
I- Serial no.
-~ Zero
L Slope
I Condition
L Action — CAL
[~ Pump Acid — Last Calibration
Calibration Base i Tubing ID
Afoam - Set
Level — Measure
SUBA Fk

= Action T CAL
Filling

- Gas Calibration Air
02
N2
CO2

- Controller Temp kp
E pH ki
pO: kd

Action — Reset
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Settings

General

Device Name

i Alarm setting

t System

i~ Log file to keep

-~ Language System (system)
English (en_US)
Deutsch (de_DE)
= A3 (zh_CN)
Espafiol de espafia (es_ES)
Francaise (fr_FR)
Italiano (it)
Tne (th)
I Select Mass flow unit
- Down sampling Algorithm for Graph plotting
- Auto restart after power failure
Enable
t Lo limit
Hi Limit
Factory default
Save setting
~ Upload setting — Database backup
L Database restore
Device type Not set
HABITAT Cell
HABITAT Ferment
HABITAT Cell Photo
L HABITAT Ferment Photo
HABITAT Cell CCT
HABITAT Ferment CCT
HABITAT Cell Photo CCT
HABITAT Ferment Photo CCT

i~ Logging level — Info

~ Debug
(days)

i~ Peltier Driver — Internal

= External

-~ Pump Driver — Normal speed

= Low speed

~ MFC version — V1.0

Lv2.0

Info

About

- IKA Cloud

 Manual

r Video User guides

~ Shop

Device information
L Firmware information
[ GUI software information
Disclaimer
IKA Cloud Registration Information
I~ Activate Cloud Communication
L Go to: IKA Cloud

/// Menu navigation

1. Screen Format
1.1 Screen Layout Desktop / Tablet

B e ot

IKA HABITAT [  Youarenotloggedin g !

Z=0ml Stirrer
co/min
¥=0ml

Available Devices

Time: hhmm:ss
ce/min

BiorecSIM (SN0123456789)

Z=0ml
ce/min

Z=0ml
co/min

2=0ml

co/min

B e e

IKA HABITAT y 4

Stirrer Set: 77

88 4

el limit
Norm.

testSetup3 (Double wall 5L Glass)
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1.2 Screen Layout Mobile

134208 - 0@ N:Ye%E
Available Devices + yavg

No devices detected

‘Scan for new Device...

Enter manually...

IKA HABITAT

2. Screen List

132408 -

Process

Stirrer

0
Temp.
0.0
pH
0.00
PO,
0.00

Pump

Acid

Base

Anti-foam

Feed

2.1 Screen of all available devices

» To display all available devices that are discovered by the software via Networks (Ethernet,

Wi-Fi® Serial port and WPAN).

B s HaiaT

IKA HABITAT

cc/min

=920 mi
cc/min

2=920ml

Anti-foam

1,130

Stirrer
88
Available Devices

BiorecSIM (SN0123456789)

Interface: Ethernet
IP address: ::ffff:192.168.56.1

Connect

=R R

& Q

Set: 0

Set: 0.00

Set: 0.00

0cc/min
0 cc/min
0 cc/min

0 cc/min

132508+ ©B@N-Y80%E

IKAHABITAT 6

Recipe
ListView
Trend

Alarm
Maintenance
Settings

Info

0 cc/min
0 cc/min
0 cc/min

0 cc/min

e o YIC

Time: bhmm:ss

>

>

Click on the plus sign "+" to open menu for re-scanning of new devices or entering the
information to connect the device manually if it's not discovered by the software.

Available Devices

BiorecSIM (SN0123456789)

Interface: Ethernet
IP address: ::ffff:192.168.56.1

Connect

ti-foam

1,180

If the device is turned on, but not discovered by the software, you can enter the information
manually to connect the device.

Device Connection

Communicatio

Host name
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2.2 Connection screen

»  The software connects to the device and loads all necessary data.

> During data synchronization, the connection may be interrupted due to the poor connection
quality or the invalid data.

»  The software will show a corresponding error message.

B K2 HABITAT - a x

IKA HABITAT
(2}

Air $=840ml Stirrer BATCH ID:201

3,750 88 Name: ik
b o

3=245|

0,
230 coimin

Acid 2=920ml

1,420 wmo

Base ¥=920ml

1,620 e

Anti-foam  £=920ml

1,130 oo

testSetup3 (Double wall 5L Glass)

»  After successful data synchronization, the main screen shows the current status.
A new log-in is not necessary.

P K4 HABITAT =] X

IKA HABITAT amn € [
w £ B8 06

BATCH ID: 214

Stirrer Set: 77

88 ..

Name: ghnjdj

Elapsed Time: himm:ss

Exhaust Set:
Foam limit
Le

fiaks!

750
Set: 14.00

PO;
13.00 ...

Ext-A

tup3 (Double wall 5L Glass)

2.3 Application Header Menu
2.3.1 Header TAB Button

)

»  For screen navigation (5) Historical data view
(D Process view ® Alarm view

() Setup view (7 Maintenance view
(3) List view (®) Settings view

(@) Trend view ©) Info view

B i s o x

IKA HABITAT amn €y 0

2.3.2 Safe-Stop

> The Safe-Stop (or Emergency) button is needed to stop all the running actions of the device.
If the button flashes, the device is in the Safe-Stop mode, the Software is no longer connect-
ed to the device and after a short time the screen "Available devices" (2.1) is shown.

> To restart the operation, the Safe-Stop button on the control unit must be pressed.

B a HamaT o x

IKA HABITAT amn €3 @

o @ 8 O

2.3.3 System color

> The color indicates which control unit is connected to the Software.

> The system color is synchronized with the LED color on the front of the control unit. The
color can be changed by clicking on the color icon.

B s HABITAT o x

IKA HABITAT ann € O

woa @ £ 8 O

2.4 Application Bottom Menu
(1) Display current setup.
(2) Current device time. Click to synchronize the device time with the Tablet / PC.
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2.5 Process view

»  Start screen with schematic illustration of the reactor vessel:
- Display of components of the current configuration
- Overview of measured values and process parameters
- Open the controller menus

) Log-in user menu and user account (Add, Edit and Delete)

) Connection status display of the currently selected connection type (Ethernet, Wi-Fi® or
Serial port)

(3) Device color indicator

) Safe-Stop

) Device date / time

) Experiment Start button (start data logging and auto mode functions)

(7) Display selected recipe

P IKA HABITAT - o X

IKA HABITAT

Exhaust Set: 50

24
Foam limit

Level limit

Norm.

test Setu UL

2.5.1 Batch information display
» Display information of current / last batch, such as ID, name, rec-
ipe used, status, time elapsed and user information entered.

BATCH ID:215

Name:

SAMPLE DATA

2.5.2 Login
Before the user is able to change any parameters value or configuration, the user is required
to log in to the device first.
Enter user name and password.

>

After log-in, the user name and the user icon are displayed.

User + Access + Right matrix

o

amn € [

Guest
(Anonymous, Monitor Operator Admin Service
no need to
login)
A to th
ccess to the M Read-only | Read-only |M Full access | Full access M Full access
Process view
A to the List
vicef/:/ass othetst g Read-only |4 Read-only |[M Read-only | Read-only M Read-only
A to th
ceess to the M Read-only | Full access |M Full access | Full access M Full access
Trend view
A to th
ceess tothe M Read-only | Read-only |M Full access | Full access M Full access
Setup view
M Sensor calibra-
M Sensor M Sensor calibration tion
Access to the i , -
R calibration |4 Pump calibration |M Pump calibra-
Maintenance M Read-only
view M Pump M Controller parame- tion
calibration ters M Controller
parameters
A<.:ces.s to tthp— M Read-only |4 Full access |M Full access M Full access
plication settings
M Factory reset
M Save setting
M Upload setting
M Database backup
Access to the M Database restore
. [0 Chang device type | Full access
System settings
[ Change logging level
O Change number of
log file to keep
[ Enable/disable
21-CFR mode
Access to the User M Full access M Full access
Management
Start/Stop process M Full access |4 Full access M Full access
Access u.serfself M Read-only | Full access |M Full access M Full access
information
M Access switch
Access to deleted/ pution o show
; / hide archived
archived data
recipe and
historical data
Safe stop button M Read-only | Full access |M Full access M Full access

65



2.5.3 Stirrer Control 2.5.4 Gas Control (Air, O2, N2, CO2)

> Mode: > Mode:
- Off: Turn off the stirrer - Off: Turn off the gas module
- Manual: Set the stirring speed manually (independent of other parameters). - Manual: Set the gas flow rate manually (independent of other parameters).
- Cascade — DO control: Stirrer control by DO cascade controller. Only the stirring direction - Cascade — DO control: Gas control by DO cascade controller.
can be set here. - Profile: Preset of up to 10 values, which are run within a certain time period.

- Profile: Preset of up to 10 values, which are run within a certain time period.
- Profile ramp: Preset up to 10 values that linearly increase or decrease the stirrer speed to

the target speed within a specified time. GACE] RS
- Chaotic: Set the upper and lower speed limits and duration for the chaotic stirring. This ot Mode. _ -
is based on an algorithm that randomly calculates the speed within a defined frame. The o oce

algorithm is used to optimize the stirring time. Set flow (cc/min)

Stirrer Control Stirrer Control

Mode:

Mode:
Rotation: Set speed (rpm):

Rotation:

Cancel

Stirrer Control

Stirrer Control
Mode:

Rotation: Loop mode:

Air Control

Profile

Loop mode:
» Mode:
Profile
T+ o+ = Loop mode:
> o —o0 o O
T Profile
[ 850 rpm K

I L

Stirrer Control Cancel

Mode:

Rotation:

Speed range in Chaotic mixing (rpm)

I+

Duration to run Chaotic mixing (Max. 23hrs 59mins)

- LT - min
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2.5.5 Gas Mixer (Air, O2)

> Gas Mixer: Set Air and O2 control mode to Manual mode.

» I the Gas Mixer is enabled the set point input from Air and Oz control will be disabled.
> Set flow: Enter flow rate in vwm (Volume Vessel per Minute), up to 2 vwm.

»  Set ratio (Slider): Change the mixing ratio of Air and Ox2.

Gas Mixer Control

Set Air ratio (%)

*

Set 02 ratio (%)

Cancel

2.5.6 Pump Control
> Mode:
- Off: Turn off
- Manual: Set flow rate, volume and rotation direction of the pump manually.
- Auto - pH control: The pump volume will be controlled by the pH controller. The pump
speed and direction can be adjusted in this mode.
- Profile: Preset of up to 10 values to be run within a certain time period.
»  Calibration information:
Show calibration information: If the parameters (for example the hose size used) are out of
range, a recalibration should be performed.
- Calibrate: Pump or hose calibration
- Filling: (pre) filling of the hose

Acid Control Acid Control

Mode: Mode:

Set flow (cc/min) Set flow (cc/min):
Rotation: Rotation:

Set volume (ml): Calibration information

Calibrate Filling

Calibration information

Calibrate Filling

Last calibration: 12/27/2018, 10:42:34
Tubing ID (mm): 3.2

Flow rate (cc/min

k (ml/pulse): 0.300

Last calibration: 12/27/2018, 10:42:34
Tubing ID (mm): 3.2

Flow rate (cc/min): 40.0- 140.0

k (ml/pulse): 0.300

Cancel Cancel

Acid Control X

Mode:

el

Profile

> 6 Lol o

— |

Cancel

» Tubing filling
1. Before the calibration, select pump "Filling" 4. Input "Tubing length" in cm
2. Click "Filling" 5. Start "Filling"

3. Choose "Tubing ID"

6. Wait until "Filling" is completed

Acid =920 ml 0 Acid Control

1,420 oo =

Mode:

Set flow (cc/min):

Anti-foam  $=920 ml Rotation:

113

Set volume (mi): =

Calibration information

Calibrate Filling @
L3

Last calibration: 12/27/2018,10:42:34
Tubing ID (mm): 3.2

Flow rate (cc/min): 40.0- 140.0

k (ml/pulse): 0.300

Acid Calibration Acid Calibration

Entering Tubing inner diameter and length. Then Click on Filling button to filling the hose. Entering Tubing inner diameter and length. Then Click on Filling button to filling the hose.

evesr | - O o | -

Filling
3

©)
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2.5.6.1 Special feeding mode for Anti-foam Control

> Mode:

- Cascade — DO (Lower Active): auto active feeding when actual DO value is lower than

set DO value.

- Cascade — DO (Over Active): auto active feeding when actual DO value is higher than

set DO value.

- Biomass Feed (Lower Active): auto active feeding when actual Biomass A.U. is lower

than set A.U. value.

- Biomass Feed (Over Active): auto active feeding when actual Biomass A.U. value is

higher than set A.U. value.

- Exponential Feed: active feeding control with “exponential equation” parameters'

setting.

Note: A.U. (absorbance unit)

Anti-foam Control

Mode:
Set flow(cc/min):
Rotation:

Set volume (ml):

Calibrate Fill

Last calibration: 01
Tubing ID (mm): 3.2
Flow rate (cc/min):
k (ul/pulse): 930.00

Anti-foam Control

Mode:

Set flow(cc/min):

Rotation:

Calibration Information
Calibrate Filling
Last calibration: 01/01/1970, 07:00:00
Tubing ID (mm): 3.2
Flow rate (cc/min): 40.0 - 140.0
k (ul/pulse): 930.000

Cancel

Anti-foam Control

Mode:
Set flow(cc/min):
Rotation:

Calibration Information

Calibrate Filling

Last calibration: 01/01/1970, 07:00:00
Tubing ID (mm): 3.2

Flow rate (cc/min): 40.0 - 140.0

k (ul/pulse): 930.000

Cancel

Mode:
Set flow(cc/min):
Rotation:

Calibration Information
Calibrate Filling
Last calibration: 01/01/1970, 07:00:00
Tubing ID (mm): 3.2
Flow rate (cc/min): 40.0 - 140.0
k (ul/pulse): 930.000

Cancel

Anti-foam Control

Mode:

Set flow(cc/min):

Rotation:

Calibration Information
Calibrate Filling
Last calibration: 01/01/1970, 07:00:00
Tubing ID (mm): 3.2
Flow rate (cc/min): 40.0 - 140.0
k (ul/pulse): 930.000

Cancel

formula [ F(t) = FO * exp (pset*t) ]

Anti-foam Control

Mode:

Rotation:

Feed start criteria:

Formulas: F(t) = FO * exp(uset * t)
FO: Intial feed rate (ml -

pset: growth rate (per -

t: feed time (hhh:mm) -

Calibration Information

Calibrate Filling

F(t) — output flowrate/gravimetric feedrate

FO — initial feedrate/gravimetric feedrate : set by user

exp — mathematical exponential function

pset — set federate : set by user; typical range is 0.05 — 0.4 but can be

lower/higher dependent on the microorganism

t — time since feedstart : automatic
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2.5.6.2 Special feeding mode for Feed Control

> Mode: Feed Control Feed Control X

- RQ feeding (Lower Active): auto active feeding when actual RQ value is lower than set

- RQ feeding (Over Active): auto active feeding when actual RQ value is higher than set
RQ value. Rotatio I - o | Cleokwise ~

- Grqvimetric: Weight-based rate feeding control in g/h, with Balance device for flask Loop mode: _ v Loop mode: _ v
weight measurement.

- Profile Gravimetric: Weight-based rate feeding control in g/h, with Balance device for Profile = Profile \ _
flask weight measurement, preset of up to 10 values as profile. > -0 -o- O | 2 o to fo- -0

- Profile Flowrate: feeding rate control in g/h and duration, preset of up to 10 values as

profile.

- pH Feed (Lower Active): auto active feeding with target volume and ratio calculation
from current fed volume of Base pump.

- pH Feed (Over Active): auto active feeding with target volume and ratio calculation from
current fed volume of Acid pump.

- Cascade — DO (Lower Active): auto active feeding when actual DO value is lower than
set active pO2 value defined in this control. e

- Cascade — DO (Over Active): auto active feeding when actual DO value is higher than
set active pO2 value defined in this control.

Feed Control Feed Control

Feed Control Feed Control

Mode: Mode:

Mode: Mode: Set flow (cc/min): Set flow (cc/min):

Set flow(cc/min): Set flow (cc/min): Rotation: Rotation:

Rotation: Rotation: Feed ratio: Feed ratio:
( with Acid pump )
Calibration Information

( with Base pump )

Calibration Information Calibration Information

Set volume (ml):

Calibrate Filling Calibrate Filling Calibrate Filling

72

Calibrate

Last calibration: 01
Tubing ID (mm): 3.2
Flow rate (cc/min):
k (ul/pulse): 930.00

Feed Control

Mode:
Set flow (cc/min):
Rotation:

Calibration Information
Calibrate Filling
Last calibration: 01/01/1970, 07:00:00
Tubing ID (mm): 3.2

Flow rate (cc/min): 40.0 - 140.0
k (ul/pulse): 930.000

Cancel

Last calibration: 01/01/1970, 07:00:00
Tubing ID (mm): 3.2

Flow rate (cc/min): 40.0 - 140.0

k (ul/pulse): 930.000

Feed Control

Set feed rate (g/h):
Rotation:

Calibration Information
Calibrate Filling
Last calibration: 01/01/1970, 07:00:00
Tubing ID (mm): 3.2

Flow rate (cc/min): 40.0 - 140.0
k (ul/pulse): 930.000

Cancel

Last calibration: 01/01/1970, 07:00:00
Tubing ID (mm): 3.2

Flow rate (cc/min): 40.0 - 140.0

k (ul/pulse): 930.000

Cancel

Feed Control

Mode:
Set flow (cc/min):

Rotation:

Set active pO2 (%sat): - _

Calibration Information
Calibrate Filling
Last calibration: 01/01/1970, 07:00:00
Tubing ID (mm): 3.2

Flow rate (cc/mi
k (ul/pulse): 930.000

Cancel

Last calibration: 01/01/1970, 07:00:00
Tubing ID (mm): 3.2

Flow rate (cc/min): 40.0 - 140.0

k (ul/pulse): 930.000

Cancel

Feed Control

Mode:

Set flow (cc/min):

Rotation:

Set active pO2 (%sat): - _

Calibration Information
Calibrate Filling
Last calibration: 01/01/1970, 07:00:00
Tubing ID (mm): 3.2
Flow rate (cc/min): 40.0 - 140.0
k (ul/pulse): 930.000

Cancel
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2.5.7 Exhaust Control

>

Mode:

- Off: Turn off

- Auto: The controller will automatically control the filter heating temperature according to
the setpoint value.

- Peltier Off/On

Exhaust Control

Filter Heater Mode:

Filter Heater (°C):

Peltier Off/On: ()

Cancel Apply

2.5.8 Foam limit Control

>

Mode:

- Off: The foam sensor will detect the foam level but will not take any further action.

- Auto: If foam is detected the controller will turn on the Anti-foam pump to add Anti-foam
agent.

On delay: Anti Foam pump delay time

On time: Anti Foam pump switch-on time

Sensitivity: Adjust the sensitivity of the foam detection sensor.

Status Indicator: Sensor status indicator (Normal / Activate).

Double detection: Use both "Foam" and "Level" sensors for foam detection, both sensors

must detect the foam, then the automatic AFOAM pump feeding will be active.

Foam limit Control

Mode:

On delay (sec):
On time (sec):
Sensitivity (%)

- —m

Low High

Double Detection

+ with level probe

Cancel

2.5.9 Level limit Control

>

Mode:

- Off: The sensor will detect the level but will not take any further action.

- Auto: If the level limit is detected, the controller will turn on the level pump to feed /
harvest the medium.

On delay: The time delay after the level sensor is active and before the Level pump Feed / Harvest.

On time: Duration for pumping.

Sensitivity: Adjust the sensitivity of the level detection sensor.

Status Indicator: Sensor status indicator (Normal / Activate).

Level control mode: Control the pump direction (Harvest: suck out / Feed: Fill-in)

Level limit Control

Mode:

Normal

Level control mode:

Harvest Feed

Cancel
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2.5.10 Temperature Control
> Mode:
- Off: Turn off

- Auto-Control: Reactor temperature control according to the setpoint specification.
- Profile: Preset of up to 10 values to be run within a certain time period.
»  Set value offset: Input of a temperature offset value
> Actuator: Select Heat blanket / Thermostat (IKA HRC 2) to control the temperature of the

reactor vessel.

Temp. Control

Mode
Set Temp. (°C)
Set value offset +/-

Actuator:

Cancel

2.5.11 pH Control
> Mode:
- Off: Turn off

Temp. Control

Mode:

Actuator:

Loop mode:

Profile

> 6

Cancel

- Auto: Control process pH value according to the setpoint specification by activating the
acid and base pumps, if these have also been set to "auto”.
- Profile: Preset of up to 10 values to be run within a certain time period.
»  Set value offset: Input of a pH value offset value.
> Digital sensor (Disable / Enable): Use the digital pH sensor as a reference for pH measure-

ment and control.

- Device ID: User defines the unique ID (2 ... 255) that matches the Modbus-Device

address setting for the digital sensor.

pH Control

Mode:

Set pH:

Offset +/-:
Digital sensor:

Device ID:

Cancel
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pH Control

Mode:
Loop mode:
Digital sensor:

Device ID:

>

2.5.12 pO2 Control
> Mode:
- Off: Turn off

- Manual: Control the output power (%) of the pO2 controller directly with the Cascade

control setting in the setup.

- Auto: Enter pO2 value (% saturate) with the Cascade control setting in the setup.
- Profile: Preset of up to 10 values to be run within a specified time period.
> pO2 Cascading: Graphical visualization of the cascade control values.
> Digital Sensor (Disable / Enable): Use DO digital sensor as a reference for pO2 measurement

and control.

- Device ID: User defines the unique ID (2 ... 255) that matches the Modbus-Device

address setting for the digital sensor.

pO2 Control

Mode:

Output (%):

Digital sensor:
Device ID:

pO2 Cascading

QOstirer QAr @02 @N2

o o o o

pO2 Control

Mode:

Digital sensor: (:)

Device ID: - _ +

Profile
1 +
> o —o

L e

pO2 Control

Mode:

Set p02 (%sat):
Offset +/-:
Digital sensor:
Device ID:

p0O2 Cascading

QOpstirer QAr @02 @N2

o o o

Cancel
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2.6 Setup (Recipe) Menu
»  Create, save and restore the setup:
- Reuse the previous configurations for the experiment.
- Generate the experiment report after the experiment is finished
- Visualization of the process view (for example reactor type, gas, pumps and accessories).
IMPORTANT:
> One of the saved setups must be assigned to every experiment before starting!

2.6.1 General

(D) Select experiment mode (Batch, Fed-batch and Continuous)

Select data recording interval

Select data saving location: internal control unit, internal or external memory, e.g. USB stick
Note: Enter notes or information for the setup.

Load the setup from the device

Save the current setup in the device

(7) Reset all settings to default values

B K2 HABITAT (=R

IKA HABITAT admin €5 [

o @ &£ 8 O

| Batch mode

I - ©
Pumps

Select logging interval
Gases

I - ©
Controllers

Cell &Medium Information S e

i R~ ©

Put note or information here

GO A il

FB=

® ® 0

Load Save Clear

testSetup3 (Double wall 5L Glass) 012}1358/ ?UMZ
2

2.6.2 Reactor

(D Reactor vessel type and size
(To effect min/max limits of parameter such as Gas flow rate and reactor vessel visualization)

2) Sparger type (only for the report)

Stirrer type (only for the report)

Number of stirrers (for visualization and report)

Filter size (only for the report)

(6) Spin filter size (only for the report)

F*Bafﬂes enable / disable (for visualization and report)
Harvest pipe enable / disable (for visualization and report)

(9) Cooling finger enable / disable (for visualization and report)

B ica s

IKA HABITAT

o
@
=3

°
@

General

Pumps

Gases

GO Al

Controllers

Cell & Medium Information

+ B

Accessories & Option

testSetup3 (Double wall 5L Glass)

voB @ £ B O

vessel

Propeller

No. of propeller

Spinfilter

Baffles @
Harvest pipe
Cooling finger @

11:39 AM
02/15/2022
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2.6.3 Pumps

> The control unit consists of 4 built-in pumps: Pump A (top) to Pump D (bottom)
> Itis also possible to add an external pump called Ext A.

(D To enable / disable the pump. A disabled pump will not be shown and can not be controlled.
(2) Combo box is used to assign the parameters to the pump (Acid, Base, Anti-foam, Level and

Substrate / Feed)

B e e

IKA HABITAT aamn € @

v B @ £ 8 O

o
@
Q.
o
®

General
Reactor

Gases

GO d il

Controllers

=]

Cell & Medium Information

pred

Accessories & Option

testSetup3 (Double wall 5L Glass) OE‘\JSC;ZALS\QZ

2.6.4 Gases

(1) Enable / Disable up to 4 gas modules for the experiment.
(2)Enable / Disable the Gas Mixer (Air, O2). When the Gas mixer is enabled the flow rate of Air

and Oz is controlled by the Gas mixer.

W e e

IKA HABITAT

General
Reactor
Pumps

Gase:

GO d il

Controllers

=]

Cell & Medium Information

pred

Accessories & Option

Save

testSetup3 (Double wall 5L Glass)

w

w £ 8 0O

@
©
»
»

Gas Mixer for mixing Air and O, @

8

11:40 AM
02/15/2022
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2.6.5 Controllers

2.6.5.1.1 DO cascade control (only) with the stirrer
2.6.5.1 pO2 controller

> To have the DO control by the stirrer speed adjustment, and then the constant flowrate for

82

(1 Enable / Disable parameters to control the pO2 value

Cascade table to control the pOz2 value

Plus / Minus button: add / remove table rows (min. 2 / max. 6)

(4) Apply button: assign the edited table to the device. (This is useful during experiment running

if the user would like to update to new control strategy or to find a proper strategy before
adding it into the recipe.)

(5) Select the output path

(Information for the report: Which gas feed was selected)

B9 s HapITaT

IKA HABITAT

o
@
=

o
@

Reactor

Pumps

GO dA i

Gases

Cell & Medium Information

B>

ies & Option

testSetup3 (Double wall 5L Glass)

2

w & 8 O

pH

@ cascadingto stirrer
@ cascadingoAr
(@ J
@ J

0)

NI ), @
®

+ Apply

Output Stirrer Air N,
(tpm) (ce/min) (ce/min) min)

O R R R R
S N T R

Select output path for Air
I - ©
ct output path for 0,

11:41 AM
02/15/2022

the gas input.

> Set the “DO cascade table”

(1) Select the tab "Setup recipe”

Select the "Controllers”

Select the tab "pO2"

Enable the "Cascading to Stirrer”

(5) Define the "minimum speed"”, ROW-0%
Define the "maximum speed”, ROW-20%

(6 Click "Apply" to save the settings

IKA HABITAT Version0.14.3

B 8 O

p02 pH

Recipe

General

Reactor Cascading to Stirrer @

Pumps Cascading to Air

Gases

Cascading to O.
Controlters (2) 3100,

Cell & Medium Information

O A il

Cascading to N

pre

Accessories & Option Cascade settings

+

Output Stirrer Air 0,
(%) (rpm) (ce/min) (cc/min)

»  Operating the pO2 control in “Auto” mode.

(1) Open the "p02" module

(2)Select the mode "Auto"

(3:)Defme the set DO value (minimum control level), unit: %sat
(@) Define the "offset +/-" (acceptable tolerance)

p0O2 Control

Temp. Set: 37.0 Mode:
29.7 c

Set: 7.50

772 ..

Set p02 (%sat):

Offset +/-:

Ostirer  QaArr @02 @N2
o o o o

Set: 100.00

7316 .0

p0O2 Cascading

® #ony

N,
(cc/min)

0-1.0
0.9
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»_ Operating the Stirrer in “Cascade - DO control” mode 2.6.5.1.2 DO cascade control by the stirrer and the gas flowrate adjustment

(D Open the "Stirrer" module > Set the “DO cascade table”
(2) Select the mode "Cascade — DO control" ~ Option 1: To have DO control by stirrer speed and Gas flowrate adjustment in the same time.
(3) Click "Apply" or "Ok" to save the settings (D select the tab "Setup recipe"

(2) Select the "Controllers”
Stirrer Set: 501 (3) Select the tab "p0O2"
0 Mode: (4)Enable the "Cascading to Stirrer"
(5)Enable the "Cascading to Air, Oz, or N2 (if needed)"
Rotation: (&) Define the "minimum Stirrer speed”, ROW-0%
Define the "maximum Stirrer speed", ROW-20%
(7) Define the "minimum Air flowrate", ROW-0%
Define the "maximum Air flowrate", ROW-20%
(8) Click "Apply" to save the settings

Stirrer Control

IKA HABITAT Version0.143
w Cg)) < 8 0

p02 pH

o
@
=,

o
@

General

Reactor @ 0 Cascading to Stirrer
Az ® O Cascading to Air

Gases
Controllers (2) | »

Cell & Medium Information O C

(CHC N e ]

»  Operating the Gas module in “Manual” mode
(1) Open the "Air" module

Select the mode "Manual"

Define the flow rate setpoint value, unit: cc¢/min

fred

Accessories & Option Cascade settings

- + Appl!
(4) Click "Apply" or "Ok" to save the settings : - _
NOTE: If another gas is required, repeat the first step for Oz, N2, or CO2 module. OL('effm ?,‘;I;?{ (cc/?.zm) (cc(/),i.n) (cc]/\‘r;m)

Air Control

cc/min
Set flow (cc/min): - +

)
0
20

o= ——F—
RN TR IR B

Select output path for Air
T

Select outout path for 0,

=0 ml
Save
cc/min

Auto pH DO (Single wall 0.5L Glass) og/sr‘f,l;;o“gz

=0 ml

cc/min

=0 ml

cc/min

Cancel Apply @
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Option 2: To have DO control by stirrer speed as the first step, and then the gas flowrate

adjustment in the second step.
) Select the tab “Setup recipe”
Select the “Controllers”
Select the tab “p0O2"
Enable the “Cascading to Stirrer”

1

(6) Define the "minimum Stirrer speed"”, ROW-0%

Enable the “Cascading to Air, Oz, or N2 (if needed)"

i Define the "maximum Stirrer speed”, ROW-20% & ROW-40%
(7) Define the "minimum Air flowrate", ROW-0% & ROW-20%

i Define the "maximum Air flowrate", ROW-40%
(8 Click "Apply" to save the settings

IKA HABITAT Version 0.14.3
El

Recipe

== General

T[J Reactor @ @) (cascading to stirrer
Pumps ® ‘) Cascading to Air
Gases

| C’ Cascading to O

Cell & Medium Information o ding to N;

Accessories & Option
@

Output Stirrer

(%) (rpm)

:
Select output path for Air
T oo v

Auto pH DO (Single wall 0.5L Glass)

/ 4

Cascade settings

Air 0,
(cc/min) 0 (ce/min)

1000
1000

2000

Admin @ o

Apply

N,
(cc/min)

05:41 PM
08/16/2022

»_ Operating the PO2 control in “Auto” mode
(1) Open the "p0O2" module
) Select the mode "Auto”

) Define "offset +/-" (acceptable tolerance)
lick "Apply" or "Ok" to save the settings

Temp. Set: 37.0

29.7 c

Set: 7.50

772 .

Set: 100.00

73.16 ..

> Operating the stirrer in “Cascade - DO control”

) Open the "Stirrer" module
elect the "Cascade — DO control"

(3) Click "Apply" or "Ok" to save the settings

Stirrer Set: 501

0

efine the set DO value (minimum control level), unit: %sat

p0O2 Control

pO2 Cascading

QOstirer QaAr @02 @N2
o o o o

Cancel

mode

Stirrer Control

Mode:

Rotation:

Cancel

0-1.0

v

+
+
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»  Operating the Gas in “Cascade - DO control” mode 2.6.5.2 pH controller

(1) Open the "Air" module (1) Enable / Disable the parameters to control the pH value

Select the mode “Cascade — DO control” (2) Select the output path

(3 Click "Apply” or “Ok” to save the settings B e o
NOTE: If another gas is required, repeat the first step for O2 or N2 module. IKA HABITAT

Air Control

4 oy
Mode:

o
@

Q.
°

®

PO,

General

cc/min

Reactor Cascading to Acid

=0 ml

Pumps

o )
| a»

Select output path for CO,

Accessories & Option
[ owmas| v

SO d il

Gases

cc/min

B =

Cell & Medium Information

=0ml

pred

cc/min
z=0ml

cc/min
Cancel

Important Note
How does the automatic DO control work in the background?
» The user defines the DO %sat (minimum control level) as the setpoint value
» The DO controller will calculate a proper %Qutput value using the PID algorithm. \estSetup3 (Double wall 5 Glass) A
- 0.0 % Output: actual DO %sat is higher than or equal to the setpoint value.
- 0.1-100 % Output: actual DO %sat is lower than the setpoint value.

» The %Output is used to calculate the setpoint value for each sub-controller within the cas- > pH control
cade.
pH control
Automatic DO control
E "=l
{ 0% [ 20% [ 40% [ 60% [ 80% [100%] ol oo Al
\280\280\280\280\420\%3 S - il

0% [ 20% [ 40% eotur'n\soc/n

0
L i A\r(owtroHer R _—
ooy| [0 150 [500 [ 250250 [ 250 o
DO controller rocess .
0% ‘200/1 40% | 60% | 80% | 100% 1
0 [ 0 | 0 [250 250 \zaw 0z controller

0% | 20% [ 40% [ 60% 100%
500 0 [0 | 000

Setpoint DO %sat
—_—

]

Acid
solution jeE=d
Base |\
solution NNg=2

N2 controller

Process variable (DO %sat)
Q N\ 4inl/Fead
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> pH control with ACID and BASE pump > Setting mode “Auto” for pH module

> Setting “Auto — pH control” for ACID and BASE pump (1) Open the "pH" module

(1) Open the "Acid" pump module (2 Select the mode "Auto"

(2) Select the mode "Auto — pH control” (3) Define pH set value.

(3) Define pump flowrate (min. and max. values depend on the tube size), unit: c¢/min (@) Define "offset +/-" (acceptable tolerance)

(4) Select a proper direction: CW or CCW

pH Control
Acid Control

) -
0 -

cc/min

Temp. Set: 37.0 -

207 .M
7.72

Set: 7.50 Offset +/-:

Calibration information

Anti-foam ¥=0ml Calibrate Filling

pO0, Set: 100.00
cc/min Last calibration: 01/01/1970, 07:00:00
Tubing ID (mm): 3.2 7 3 1 6 o
¥=0ml Flow rate (cc/min): 40.0 - 140.0 * %sat
k (ul/pulse): 930.000

cc/min

Cancel

Important NOTE:

(&) Open the "Base” pump module How does the automatic pH control work in the background?

(© Select the mode "Auto — pH control” » The user defines the pH set-value as setpoint input for the system.

(@ Define the pump flowrate (min. and max. values depend on the tube size), unit: cc/min » The controller determines the difference between the setpoint and actual values measured
(8 Select a proper direction: CW or CCW with the pH sensor.

- If the actual pH value is within the range of the setpoint (incl. +/- offset), no action is initiated.
- If the actual pH value is out of the range of the setpoint value (incl. +/- offset) the PID con-

. troller calculates the necessary supply of ACID or BASE within a cycle of 30 seconds.
cc/min

IR -
Set flow (cc/min): - + Automatic pH control pH sensor  ENCHERYYINE Feedback pH set value
Base z=0ml
v ==

O Rotation:
- Yes
cc/min l

Calibration information
. u " 0
Anti-foam =0 ml Calibrate Filling In +/- “Offset" range?

=0 ml Base Control X

Mode:

cc/min Last calibration: 01/01/1970, 07:00:00
Tubing ID (mm): 3.2
PID calculation

l
=
5]

Feed >=0ml Flow rate (cc/min): 40.0 - 140.0
O k (ul/pulse): 930.000

cc/min l% output PID

ACID " control

in cycle time of 30 sec

BASE

Note:
cw = clockwise
ccw = counter clockwise

'ﬁ‘ ) 1

Base Acid
solution [ solution
! )

Y N
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€

2.6.6 Cell & Medium information

) Input of cell / product information
2) Input of culture medium information
(3) Input of supplement information

B s rmiaT

IKA HABITAT

General
Reactor

Pumps

GO dA i

Gases

Controllers

En

formatior

ies & Option

fred

testSetup3 (Double wall 5L Glass)

w

w £ B O

Cell information @

Name

o x

admn €5 [

Lot number

Description

cuure medim ()

Name

Lot number

Description

C— )

Name

Lot number

Description

11:42 AM
02/15/2022

A

2.6.7 Accessories & Option

(1) Enable / Disable Light panel

Enable / Disable CO2 sensor

Enable / Disable Conductivity sensor
Enable / Disable Turbidity sensor
Enable / Disable External signal module

(6) Enable / Disable External signal module

IKA HABITAT version1.08

W o

General

Reactor

Pumps

Gases

Controllers

Cell & Medium Information

Option

Light Panel
» @

CO, Sensor @
@

Conductivity Sensor @

@
Turbidity Sensor @
0 )

Ext-A Signal

@

(7)Enable / Disable BlueVary
)Enable / Disable CggBior

) Enable / Disable Weight Sensor
)Enable / Disable Redox Sensor
[ VEnable / Disable Incyte Sensor
(2Enable / Disable Excell Sensor

AT amn €)

Ext-B Signal

a»

BlueVary @
@

CgqBior @
@ ®
Weight Sensor @
a»

Redox Sensor @
a»

Incyte Sensor
a» o

EXcell Sensor @

11:49
.Qf 18/2/2568 BE

2.6.8 Loading a recipe

(D Table to display all the recipes

Column overview with sorting function (ascending or descending)
Button to delete the selected recipes

Selected column to filter the recipes

Input of the filter keywords to filter the recipes

(6)Button to load the selected recipes

Recipes

I -, O

mation
1d Ak@ Name Author Date created
6 testSetup6 admin  14:29:5520/12/2019

3 testSetup3 admin 14:29:55 20/12/2019

L)
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2.7 List View Menu 2.8 Trend View Menu

» Table view of all parameters: > Graphical display of current data.
- Actual value > Data is updated when the software is connected to the IKA HABITAT or when the device
- Setvalue time is changed.
- Unit »  For data synchronization, click the Sync button. (Only when the experiment is running, there
- Operating mode is no data when the experiment is not running).

1) Display all current parameter values (click to adjust the color and the scale).
Change the updating time of the graph
(3) Graph synchronization button
B o o« To transfer all the data from the device to the software, as the device can be operated with-
wn €@ O out an active user interface.
BE AWARE: Depending on the data size of the experiment it may take some time!
w w #F£ B O (@) Export Data to CSV or save to USB
(B Click in the area of the graph to display a cursor line (display of all the values in this area)

- Alarm conditions
- Alarm status
- Error codes

Actual Set Unit Alarm Alarm
value value enabled status

IKA HABITAT version1.08

PO,
Exhaust

M B @ £ & O

T on oo [ N Cooo o BENNGE BENEE Y O ©
26.1 6.98 121.34 501 0.00 0.00 0.00 0 Al

Stirrer
Air
0,
N,
co,
Acid

Base

Anti-foam
Feed
Subs

Foam limit

Level limit
CO, probe
Conductivity probe
Turbidity probe
Light panel

11:42 AM
02/15/2022

testSetup3 (Double wall 5L Glass)

11:49
18/2/2568 BE
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(1) Enable / Disable Trend display

Select the parameters to be displayed
Select the color

Enable / Disable the function of auto scaling
Set the minimum Y-Axis scaling

(&) Set the maximum Y-Axis scaling

IKA HABITAT version1.08

w B O

CgqBior Au. [BVZ " Wol%| BV_ voL% An [©) ©)
6.98 121.34 501 0.00 0.00 0.00 0 Al Export D

Trend settings #1

YY) .

v
v

Auto sealing: () @)

Max Y-Axis:

- -

2.9 Historical data

(D Table view of all the experiments

(2) Graph display of historical data series

(3) Button to export graphical data (PNG format)

(@) Graph legend, click to show / hide

() Button to print the graph

(6)Button to export data as CSV file

(@) Button to create a PDF file

(8 Button to save data to USB drive connected to the control unit
(9 Button to open the Filter menu

@0 Button to delete the selected experiment

@D Table menu bar to sort the data (ascending / descending)

B s oA

IKA HABITAT verion0147

w 8 @ £ 8 O

Janl 1:50:44
Marker_ 0 Take sample’01

,‘1\\';114,‘ Jan 14,11:51 Jan 14,12:00 12:1( Jan 14,12:19
Experiment files
Start date Name Recipe Operator
14:44:31 29/11/2019 test1235 testSetup

09:21:1527/11/2019 test2 testSetup2

13:07:49 02/12/2019 retresdfs testSetup1 admin

11:31:5502/12/2019 tilamfkd testSetup2 admin

Initializing

Idle

PR
@O

]

]
©

10:54 AM
08/05/2022
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2.10 Alarm view
>

The screen shows the alarm messages for the running experiment. If no experiment is run-
ning, the alarm messages will not be recorded.

The alarm messages of each experiment will be saved and listed with the experiment data in
_ the report.

) Table menu bar to sort the data (ascending or descending)

(2) Ascending or descending markers for the sorting

B s HagTaT

woa @ o B O

N @ Timestamp Error code Description

: e Temperature
el M Temperature set value not reached

Power Supply
28/2/2017:23:55 01290009 e hutdown

09:02 AM
08/05/2022

2.11 Maintenance Menu

2.11.1 Sensor Calibration

1) Date / time of last calibration

Sensor serial number

Sensor raw value at zero point calibration

Sensor raw value during slope calibration

Probe condition: Minus sign means that the sensor is no longer suitable for further experi-
ments and should be replaced.

CAL button to start the calibration process

IKA HABITAT version 108 AT amn € =

M B @ £ £ O
@) @ ® 6 6 e

Cahli::::wn serial no. Zero Slope Condition Action
Pump Calibration

Gas Calibration

Controller

2.11.2 Pump Calibration

1) Date / time of last calibration

Tubing inner diameter.

Set value of the last pump calibration

The value that can be measured by the device when the user specifies a setpoint value.
Calibration constant (internal value for setting the pump accuracy)

(6) CAL button to start the calibration process

Filling button: used to fill an empty tube before calibration, also useful to use before and
after the experiment.

IKA HABITAT version .08 A7 admin €

w U 6
Maintenance

€ Sensor Calibration @ @ @ @ @

Last Tubing ID Measure
@ Pur

alibration calibration (mm) (ml) Action

(ml/pulse)

A

Filling

<) Gas Calibration

1l Controller

Base

Anti-foam

Feed

Subs-A
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2.11.3 Gas Calibration

» Individual gas calibration by "Slope" and "Offset" value.

> Users collect the raw flowrate measurement data compared to the standard meter within
the interested range, then find the correct slope and offset value from the linear equation
y=Mx+C

IKA HABITAT version1.08

W (1))

Maintenance

€ Sensor Calibration Action

@ Pump Calibration

5 Gas Calibration

1l controller

NOTE: How to find the slope value for each gas, from raw measurement data?

Standard Meter

Set value H.’:l;ahl Siand:rzr:)Meler %De;léahon y=0.998x +21.724

200 200 215 93 o R?=0.9995

300 300 330 9

400 400 435 %2 - - Note:

50 500 521 %

600 600 618 o7 » Slope = M*100 (no decimal)
70 700 720 o7 -

80 800 820 % o = Offset = C*1 (no decimal)
%0 900 918 % |2

1000 1000 017 % a0

2.11.4 Controller

> This menu is intended for the experienced users with knowledge of PID controller systems to

enter their own PID controller parameters.

kp constant for the PID controller.

ki constant for the PID controller.

kd constant for the PID controller.

Button to reset the PID controller parameters to default values

)pO2 separate PID for Stirrer (Disable<->Enable):
Disable: Use same PID parameters for Gases and Stirrer
Enable: Separate PID parameters for Gases and Stirrer.

IKA HABITAT version1.08

W ((a})

Maintenance

€ Sensor Calibration
@ Pump Calibration
<) Gas Calibration

| controller

PO,

pO, (Stirrer)

@ O pO, separate PID for Stirrer

4

Admin €23

13:46
27/2/2568 BE
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2.12 Settings Menu

2.12.1 General

(1) Change the device name

(2) Select the user language

(3) Select the device time zone.

Set the flow rate unit

(5) Data downsampling Algorithm
- Average: All data within a 15 minute cycle will be averaged and displayed as one point.
- LTTB: The algorithm will keep all peaks and valleys of the graph before downsampling to

display all data in the original.
(6) Enable / Disable Auto Restart on power failure. The duration of the power failure can be set.

B s e o x

IKA HABITAT aimn € [

o @ £ 8 0O

| Device Name

809  Alarm setting

b

Language
Device Time Zone
Selected Mass flow unit

Down sampling Algorithm for Graph plotting

Auto restart after power failure

Enter duration

Power failure |

testSetup3 (Double wall 5L Glass)

2.12.2 Alarm setting

1 Enable / Disable alarm limits
Lower limit: If the actual value is lower than the lower limit, an alarm will be triggered.
Higher limit: If the actual value is higher than the higher limit, an alarm will be triggered.

1
2
3
B e HeBTaT

IKA HABITAT
Settings

= General

808 Alarm setting
¥ System

testSetup3 (Double wall 5L Glass)

(_O)
(_©)
@
»
(_O)
)
@
© )
)
)
)
O )
@
0 )

o e
@

Temp. (°C)
pH (pH)
PO, (%sat)

Exhaust (°C)

Lo limit Hi limit

Stirrer (rpm)

Air (cc/min)

0, (cc/min)

N, (cc/min)

€O, (cc/min)

Acid (cc/min)
Base (cc/min)
Anti-foam (cc/min)
Feed (cc/min)

Subs (ce/min)

12:50 PM
02/15/2022
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2.12.3 System

@ Notice!

»  This section should be used carefully!

> The menu allows to change the system parameters, delete or restore configurations that

may not be compatible with the device!
»  Access to this menu is reserved for Admin Level users!
> However, some menus require IKA service permissions with a service password to access and
change the parameters.

1) Restore factory default configuration.

Export the current JSON file.

(3)Import a JSON file and upload new device configurations.

(4) This function is only for IKA Service.

This function is only for IKA Service.

) Change the device type.
Only for IKA Service!
The changing of the device type is necessary if new device components or PCBs have been
added.

(D This function is only for IKA Service.

This function is only for IKA Service.

This function is only for IKA Service.

This function is only for IKA Service.

@)This function is only for IKA Service.

IKA HABITAT version .08 [T amin €Y

w £ B

Settings

== General
Alarm setting
— —— [
I o

System Save setting

= e

Device type: Peltier Driver: nternal v©

{ABITAT Ferment

Logging level: Pump Driver:

Log file to keep (days): MFC Version:

13:46
ﬁ 27/2/2568 BE

2.13 Info Menu

(D) About: HABITAT device information

(2)IKA Cloud: Registration information for the IKA cloud
(3)Manual: Open HABITAT operating instructions

@

5

)Video Users guides: Link to YouTube Turtorial Videos
)Shop: Link to HABITAT product page on IKA homepage

[ s HagITaT o x

IKA HABITAT aomin Y [

w B @ &£ 8 O

Device information
KA Cloud @ Device ID: IKA-BR-1234
Manual @ Product name: Habitat-C

Video User guides @ Product: IKA-BR-54268745

2 50 ©

Firmware information
Version: 0.0.0

Build Number: 28062019

GUI Software information
IKA Habitat 0.9.9

Build Number: 20221102

Disclaimer
This program is provided AS IS with NO WARRANTY OF ANY KIND,
INCLUDING THE WARRANTY OF DESIGN, MERCHANTABILITY AND

FITNESS FOR A PARTICULAR PURPOSE.

testSetup3 (Double wall 5L Glass) 012/21%2/ ;(;MH

105



106

2.14 How to export cultivation data from HABITAT Control Tower?
2.14.1 During cultivation: Trends view tab

(D Export *.csv file to the control device (iPad/Tablet/Laptop)

(2) Export *.csv file directly to the USB drive

IKA HABITAT version1.08

M OB D o & O

om0 on oo [ I Cocoo ~ B
26.1 6.98 21.34 501 0.00 (0]

"

Toezsayssn

00 1 0576

RS RRRT AR YRR,

AT amin €)

~/ Export D...

2.14.2. Finished cultivation: Historical tab

(D “Export to CSV" (CSV file, to iPad/Tablet/Laptop)

IKA HABITA

17:57:51 18/01/2024
8 01
20:15:36 03/01/2024
3903/01
6:09 19/12/2023

(2)"Generate report” (PDF file, to iPad/Tablet/Laptop)

XDtest auto

RDtest auto DO 18jan24

RD test auto DO
pump pro ump
test pump profile 01 ProfilePump
- 0 e
DW-2L-default

st pul

Test Gravimetric profile

[k
Generate report

Finished
Fini
Finished
Finis
Finis

Exportto CSV
(=N
18:48:42 18/01/2024 RDtest auto DO 18jan24 Finished
17:57:51 18/01/2024 RD test auto DO Finished [Ela
3 01/2024 t pump profile 02 ofilePump Finished
20115:36 03/01/2024 test pump profile 01 ProfilePump Finished
01 st pump profile Finis
16:36:09 19/12/2023 Test Gravimetric profile Finis:

— T T T T T T T
e T A N A N e N M e L A A e A T
A ISTROET TN ), D) A0 (8o VL FOMM LAIEVEL A O o) PSS (5 P0m002 PROTWDR PGS R, s
e
I L
B
O s
S Y
S e e
L e e
S,
S,
S
B Y Y Y
S e e

IKA

designed for scientists

IKA Habitat - Batch Report

/// RD test auto DO ZACH

|ID: 122

| Initlalize date: Jan 18, 2024 - 18:02:51
| Initlalize time (dd:hh:mm): 00:00:33
| Device Serlal number: 930000002

| Note:

Trend chart

| Author: admin

| Device Firmware version: 2.0.9

| Start date: Jan 18, 2024 - 18:36:29

| Cultivation time (dd:hh:mm): 00:00:00

| Recipe: DO-ZACH
| Stop date: Jan 18, 2024 - 18:37:25
| Status: Finished

| GUI Software version: 1.0.6

7aa{an{z00{ 608 r_

s0s(ma (35

1.

o'oa! o
Jan 61003

Further Information

des 101011 Jen 110 10:20 Jon 10,1620

s o L c b
I 18,187
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(3)"Save to USB drive” (CSV file, to USB drive)

IKA HABITAT version 10

124
123 18:48:4218/01/2024 RDtest auto DO 18jan24 admin Finished

180251 18/01/2024 RD test auto DO ZACH DO-ZACH Finished W

RD testauto DO @

test pump profile 01 ProfilePump i Finished |

Finist..

(L8 A e, e

Toezsayssn

& w00t TR

27 15 How to save the cultivation data to iPad?
1:: Select the experiment file on the History page.
(2) Click on "Export to CSV" or "Generate report"

IKA HABITAT Version1.0.7

Start date
09:13:33 27/09/2024
17:34:00 26/09/2024
11:32:30 26/09/2024
16:23:22 19/09/2024
19:41:10 18/09/2024
16:05:40 18/09/2024

:37 13/09/2024

SW2L-PID-THM ()

19:05 Tue10ct

Name

RDtest-exp-27sep
RDtest-extpump-26sep-02
RDtest-extpump-26sep
RDtest-exp-19sep
RDtest-exp-18sep
RDtest-PID-18sep

RDtest13sep-auts

RDtest-autoDO-16sep_1726457641_full ~ €)

om0 10368
102 103638
1om02 10.0030
1om0 1028
1502 100238
1o 10asis
1om02 10:058
12020 10:0638

1m0 10508

1m0 r0ssis
1m0 105538
1m0 10588

3 Wait until the file is completely exported to iPad
(@) Click on the "Share" icon
(5) Click on "Save to files"

Experiment files

Recipe
DWS5L-extPump
DWS5L-extPump
DWS5L-extPump
DWS5L-extPump
DWS5L-extPump
SW2L-PID-THM

SW-2L-default

i) SASE(m) ASOM(m) LEVEL(m) FOAN LW LEVEL L0 Af(com) O2(ccm) Natcam) CORcam) |1

Operator
admin
admin
admin
admin
admin
admin

=]

Text Document

AirDrop Messages

Copy
Print
Add Tags

Save to Files 6

status
Finished
Finished
Finished
Finished
Finished

Mail

SAVE TO ES File Explorer

Edit Actions...

1/10/2567 BE

e 100% .-

[ﬁ Done

RDtest-autoDO- 1ssep 1726457641_full

Notes

B 00O @ @

©0®

Rei

109
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(®) Select the "On My iPad" tab
(7) Wait until the file is completely saved on the iPad
(8) Click "Done" to finish and close the file.

Cancel < > OnMyiPad

@,,-

RDtest- Test KU
autoD...ull.csv 2items

Locations

@ iCloud Drive

@ ES File Explorer

Tags

@ Red
© Orange
o Yellow
@® Green
® Blue
® Purple 2items
® Gray

O Work RDtest-autoDO-16sep_1726457641

Fo Ll
M Done

HHHHEHHEHHHBHEEHHHHBBEHHHHBEE

§gggeeeessss

000

1072038 1720057048

19:57 Tue 10ct

RDtest-autoDO-16sep_1726457641_full

TeSUTCA0700 sl 30) STIAER) TN o) 00URER) ACI() | BASE() AROAK) LEVELI) FOM LT LEVEL LT AIcm) O3 W) COAcm) | SUBS A ECPROBESc)€O3_1RO8E(1)| TSI, PROBENTY) LIGHTCkgowr) WARKER
B w2 om0 0 0 o 3 B o 0 0 0 e
" wa m w0 0 0 o B B o e
o w2 m e o 0 o o s B e o e
” i om o wmm o o o o 2 . PR )
" i om mm o 0 o o 3 . DR R
x.. D S . D o om
,.. e w0 0 o o s . DR R O
x.. T N . DR )
o W om mm o o o o 3 . s o o m
w0 s om me o o o o 3 . W oo o o om
o i om me o o o o 3 . e e o em
5 W w ew o o o o 3 . w0 o o m
s W ow @m0 o o o 3 . W o o o om
w s o» @m0 0 o o 2 . s e 0 0 e
o w om em o o o o 3 . e o o m
us s w es o o o o 2 B 5 o o 0 om
s om we o 0 o o 3 . e o o om
e W v @m0 0 o o 3 . e e o m
e W v ww o 0 o o 2 . e o o om
e W w ew o 0 o o 2 B e o o m
- Wi ow ww o 0 o o 3 . e e o em
N wa p ww o 0 o o 3 B e o o m
m wa o @m0 0 o o 3 f © e o o m
s W aw em o 0 o o 3 . DR )
" s @m0 0 o o 2 s w o o o Jem
B s om aw o o o o 3 . noo o o om

seese 030 . e w an o o o o 3 . B o o o om

2.16 How to check the saved file on iPad?

(D Click the "Files" app on iPad
(2)select the "On My iPad" tab
(3)search for your file name

La 156 7 18
20 21 22 23 24 25 26
27 28 29 30 31

19:08 Tue1Oct

G} e | <
Files

@) Recents

=9 shared

Locations v

@ iCloud Drive

C_)

(3 EsFile Explorer

'@ Recently Deleted

Tags v
® Red

Orange

Yellow

Green

Blue

Purple

Gray

> OnMyiPad

RDtest-
autoD...41.pdf
Today 19:06
661KB

§9

RDtest-
autoD...full.csv
Today 19:05
32KB

£ 88

Test KU
2items

3items

Select

Q Search

100% =)

111



2.17 How to share cultivation data with another Apple device (e.g. iPhone)? () Activate "AirDrop” on iPhone

(D Select the experiment file on the History page () Select the iPhone name on the iPad, then accept the file transfer pop-up on the iPhone
(2) Click on "Export to CSV" or "Generate report” device

(3)Wait until the file is fully exported to iPad (8 Wait until "file sent" is completed

(@ Click on the "Share" icon (9 Click "Done" to finish and close the file
() Click on "AirDrop”

19:07 Tue1Oct 100% -

IKA HABITAT version1.0.7 / RDtest-autoDO-16sep_1726457641_full ~ (™ Done

W OE @ o & O L 20-16sep 1726457641 full s

1692020 103428 o %2 m AirDrop a Copy Done [3oke
o035 " PREY
s so3sn w w2 m
o o6 » w2 m
D " = 2 OtherPeople ®
e e | D =
s o 0 s m [ )
16/9/2024 10:38:38 100 %3 2w es Mail Notes Rel
s o mx w3 iPhone
o 100 w w3 m
sep o @ w2 om
a0 o w0 o
sz o w2
= @
oo oz - s
s o ..n s w
e s s om
e | %
s oz ™ s ow
leil2 : g e =]
s soaen us W w
REGILEIIES e e e Explorer
Start date Name Recipe Operator status 161972024 10488 %3 7w
33 27/09/2024 RDtest-exp-27sep DWS5L-extPump admin Finished .Z:;,:::' = e |
= 16/9/2024 10:50:8. 124 %3 27
s oo .u w2 m
oo iosis 10 w w
s oz » w2 om e o
e = w2 nm ) oo o
s oz = w2 om oo .
s sz s s om o o
s sosin i > m o o
s sosas i N e — R — a0 .
s oz o B P P P P R B W0 o o om  om a0 a0 o
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/Il Autoclaving
@ Danger!

>

>

After autoclaving: Be aware of the hot surfaces!

During autoclaving, there must be no water in the condenser.

HA.cn: Fill the condenser with water only after autoclaving! For autoclaving remove the
filling cap of the condenser.

—e (losed port
@ —> Covered with foil
—o Leave it open

Autoclaving

Exhaust filter

Sparger
Coupling
Temp Harvest
4in1 Inoculation
DO
Level pH
Cooling figure
Baffle Reverse
Reverse

Water connector

Water connector

Autoclaving

>

>

Before autoclaving, please remove the motor and keep the connectors of double-walled
glass vessel open!

During autoclaving, there must be no water in the condenser. Fill the condenser with water
only after autoclaving! For autoclaving remove the filling cap of the condenser.

Autoclaving

W =

Autoilaving
Keep open

&—

Caution!

Check that the reactor vessel fits the autoclave device!

Avoid overpressure in the system during autoclaving!

Keep at least one connection port on the lid open during autoclaving!

Keep the exhaust filters open.

For double-walled reactor vessels, keep the water connections of the double jacket open!

Steps for autoclaving

>

>

>

Place the reactor vessel in the reactor vessel stand, and then close and fasten the lid!
Mount the components / sensors to the lid.

Fill medium into the reactor vessel (if you use a double-walled reactor, do not fill water into
the double jacket).

Remove the sensor cables.

Remove the motor.

Close the caps to protect the sensor connectors.

Cover the sensor connections.

Use caps, clamps or aluminium foil to cover the connections.

Carry the reactor vessel only by the carrying handles on the reactor vessel stand!

Place the reactor vessel with the reactor vessel stand in the autoclave (e.g. 25 ... 30 minutes
at 121 °C, liquid cycle).

After autoclaving, wait until the system cools down.
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/I Inoculation /// Harvesting

» Blow torch flame over the coupling to sterilize again before opening it for inoculation. » There are different methods for harvesting or emptying the reactor vessels:

» There are different options for the inoculation: - Direct pouring into an empty vessel or transferring to another vessel under the laminar flow
- Use a syringe and the septum port. Pierce the syringe needle through the septum port. hood.
- Open the port and add the liquid directly under the laminar flow hood. - Connect the sterilized silicone tubing to the harvesting tube and pump it into a prepared

container using the peristaltic pump. This method is recommended for the viscous cell.
- Apply overpressure to the vessel. This method can be used if the harvesting hose is used.
Inoculation First, clamp the hose to block the escaping gas. Then turn on the gas flow system (maxi-
mum pressure 1.5 bar) and slowly adjust the flow rate.

/Il Sampling

Sampling
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Interfaces and outputs

The device can be operated by computer via an RS 232 or USB port using labworldsoft® labo-
ratory software.

The device software can also be updated with a PC via the RS 232 or USB port.

Note: Please comply with the system requirements together with the operating instructions
and help section included with the software.

/// USB interface

The Universal Serial Bus (USB) is a serial bus for connecting the device to the PC. Equipped with
USB devices can be connected to a PC during operation (hot plugging). Connected devices and
their properties are automatically recognized. The USB port can also be used to update firmware.

/// USB device drivers

First, download the latest driver for IKA devices with USB port from:
https://www.ika.com/ika/lws/download/usb-driver.zip

Install the driver by running the setup file. Connect the IKA device through the USB data cable
to the PC. The data communication runs through a virtual COM port.

Note: The USB driver is unnecessary for Windows 10 system. Don't install it for Windows 10
system!

/// RS 232 interface

Configuration

» The functions of the interface connections between the device and the automation system are
chosen from the signals specified in EIA standard RS 232 in accordance with DIN 66 020 Part 1.
For the electrical characteristics of the interface and the allocation of signal status, standard RS
232 applies in accordance with DIN 66 259 Part 1.

Transmission procedure: asynchronous character transmission in start-stop mode.

Type of transmission: full duplex.

Character format: character representation in accordance with data format in DIN 66 022 for
start-stop mode. 1 start bit; 7 character bits; 1 parity bit (even); 1 stop bit.

Transmission speed: 9600 bit/s.

Data flow control: none

Access procedure: data transfer from the device to the computer takes place only at the comput-
er's request.

/// Connection between the device and the external devices
» PC 1.1 Cable: This cable is required to connect RS 232 port to a PC.
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/// Connection capability
> Wi-Fi®
. . Wi-Fi®
___GUI (105 App)
i GUI (Windows) i
: : GUI (i0S App)
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> RS 232 /USB > Remote

RS 232 / USB Remote

GUI (Windows) GUI (Windows) Router & hub >
outer & hu

Internet Internet Ethernet

&

Internet Ethernet, Wi-Fi®

0

<«———» | GUI (Windows)

USB / Wi-Fi® /

2@ 0
3R B

@ ® ® Ethernet / @ (i(é‘))?
0
Internet  Wi-Fi®, 3G / 4G B .
> Ethernet insta\led

Ethernet > VPN

GUI (Windows)

Router & hub

Internet

Ethernet

Internet Ethernet

&

Internet Ethernet, Wi-Fi®

® 9999

> Ethernet + Wi-Fi®
Internet  Wi-Fi®, 3G / 4G

Ethernet

(F)

Ethernet

Ethernet + Wi-Fi®
GUI (Windows)

»  IKA Cloud

Ethernet

Wi-Fi® Router

@ IKA Cloud
Ethernet Gu L
(i0S App) [D

IKA Cloud

Router & hub Internet

(@)

Ethernet

Internet
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Maintenance and cleaning

/// Maintenance Checklist

Component Check Before Note
use
Reactor vessel > Don't use if there are any visible cracks or
Visual inspection X damages
> Replace if necessary
Hoses (gas & liquids) > Don't use if there are any visible cracks or
Visual inspection X damages
> Replace if necessary
Electrical components > Don't use if there are any visible cracks or
(Motor, Heating jacket, Visual inspection X damages
Sensors...) > Replace if necessary
Sealings, O'Rir_\gs (con- > Don't use if there are any visible cracks or
nectors and stirrer shaft Visual inspection X damages
coupling) > Replace if necessary
Filters > Don't use if there are any visible cracks or
Visual inspection X damages
> Replace if necessary
Other components made > Don't use if there are any visible cracks or
of glass Visual inspection X damages
> Replace if necessary
pH- and DO- sensors > Don't use if there are any visible cracks or
Visual inspection y damages
Calibration > Replace if necessary
> Refer to software, use calibration guide
Foam- and Level- sensors Adjust sensitivity X

/// Cleaning

For cleaning disconnect the mains plug!

Use only cleaning agents which have been approved by IKA to clean IKA devices:

Water containing surfactant / isopropyl alcohol.

Wear protective gloves during cleaning the devices.

Electrical devices may not be placed in the cleansing agent for the purpose of cleaning.

Do not allow moisture to get into the device when cleaning.

Before using another than the recommended method for cleaning or decontamination, the
user must ascertain with IKA that this method does not destroy the device.

For parts in contact with medium, please take them for the autoclaving after the cleaning!

/// Ordering spare parts

When ordering spare parts, please give:

- device type.

- serial number, see type plate.

- position number and description of spare part, see www.ika.com.
- software version.

/] Repairs

Please only send devices in for repair that have been cleaned and are free of materials which
might present health hazards.

For repair, please request the “Safety Declaration (Decontamination Certificate)” from
IKA or use the download printout of it from IKA website at www.ika.com.

If your appliance requires repair, return it in its original packaging. Storage packaging is not
sufficient when sending the device - also use appropriate transport packaging.

Accessories

>

For accessories see www.ika.com.
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Error codes

/// Table "Error codes"

» The fault is shown by an error code on the display as following if the error occurs.

Proceed as follows in such cases:

- Turn off the device by using the mains switch.
- Carry out corrective measures.

- Restart the device.

Error code | Causes | Effect | Solutions

01290009 - Power Supply shutdown

01172915 - Level Sensor disconnected

Causes » No signal from sensor
Effect > Level control is not active
Solutions > Check the cable connection

> Check the sensor
> Contact customer service

01140615 - Heater contact disconnected

Causes > No signal from Heater
Effect > Heater off
Solutions > Check the heater cable

»  Check the heater
»  Contact customer service

01090615 - Exhaust (Filter Heater) contact disconnected

Causes > AC Power failure

Effect > Device stops

Solutions > Check the AC power supply
> Check the fuses

> Contact customer service

01380615 - Stirring contact disconnected

Causes > No signal from Filter heater
Effect > Filter heater off
Solutions > Check the filter heater cable

> Check the filter heater
> Contact customer service

01011315 - Air Flow disconnected

Causes > No signal from motor
Effect > Stirrer off
Solutions > Check the motor cable

> Check the motor
»  Contact customer service

01383610 - Stirring Speed blocked

Causes > No gas input
Effect > Air control is not active
Solutions > Check the gas supply and tubing

> Contact customer service

01261315 - Oxygen (Oz) Flow disconnected

Causes > Motor does not run
Effect > Stirrer motor off
Solutions > Check the cable connection

> Check the sensor
> Contact customer service

01392915 - Temperature Sensor disconnected

Causes > No gas input
Effect > 02 control is not active
Solutions > Check the gas supply and tubing

> Contact customer service

Causes > No signal from sensor

01021315 - Carbon dioxide (CO2) Flow disconnected

Effect > Display 0.0
> Temperature control is not active

Solutions > Check the cable connection
> Check the sensor
»  Contact customer service

Causes > No gas input
Effect > COz control is not active
Solutions > Check the gas supply and tubing

> Contact customer service

01072915 - Dissolved Oxygen (DO) Sensor disconnected

01251315 - Nitrogen (N2) Flow disconnected

Causes > No signal from sensor

Effect > Display 0.0
> DO control is not active

Causes > No gas input
Effect > N2 control is not active.
Solutions > Check the gas supply and tubing

> Contact customer service

Solutions > Check the cable connection
> Check the sensor
»  Contact customer service

01563610 - Pump A Speed blocked

01132915 - Foam Sensor disconnected

Causes > Pump A does not run
Effect > Pump A stops
Solutions > Visual inspection of the pump head

> Open the pump head and perform a test
> Contact customer service

Causes > No signal from sensor
Effect > Foam control is not active
Solutions > Check the cable connection

> Check the sensor
»  Contact customer service
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01573610 - Pump B Speed blocked

Causes > Pump B does not run
Effect > Pump B stops
Solutions > Visual inspection of the pump head

> Open the pump head and perform a test
> Contact customer service

01583610 - Pump C Speed blocked

Causes > Pump C does not run
Effect > Pump C stops
Solutions > Visual inspection of the pump head

> Open the pump head and perform a test
»  Contact customer service

01593610 - Pump D Speed blocked

Causes > Pump D does not run
Effect > Pump D stops
Solutions > Visual inspection of the pump head

> Open the pump head and perform a test
> Contact customer service

» If the actions described fails to resolve the fault or another error code is displayed:
- Contact the service department.
- Send the device for repair, including a short description of the fault.

/// LED Status

1. Processing Status

IKA HABITAT

Stirrer Temp pH  pO:2 Level Foam

.1 Stirrer

1.1 Color status:
GREEN: Stirrer is working normally.
ORANGE: Warning, actual value out of the alarm limits
RED: An error has occurred.
OFF: Stirrer motor cable is not connected.

.1.2 Possible Error codes:
01380615: Stirring contact disconnected / Check the motor and the motor cable.
01383610: Stirring Speed blocked / Check the motor and the drive shaft.
01382708: Stirring Safety Circuit safety circuit cut-off / Contact customer service.
01383502: Stirring Setting upper limit / Check the alarm setting.
01383503: Stirring Setting lower limit / Check the alarm setting.

“ v v v o~ ~ v o~ o~

1.2 Temp

1.2.1 Color status:

> GREEN: Temperature control is working normally.

> ORANGE: Warning, actual value out of the alarm limits

> RED: An error has occurred.

> OFF: Temperature sensor cable is not connected.

1.2.2 Possible Error codes:

> 01392915: Temperature Sensor disconnected / Check the temperature sensor and the cable.
01393502: Temperature Setting upper limit / Check the alarm setting.

01393503: Temperature Setting lower limit / Check the alarm setting.

01140615: Heater contact disconnected / Check the heat blanket and the cable

01142920: Heater Sensor fault / Contact customer service.

01143808: Heater Temperature safety circuit cut-off / Contact customer service.

01143824 Heater Temperature too high / Check the installation of the heat blanket on the vessel.

1.3 pH

1.3.1 Color status:

> GREEN: pH control is working normally.

> ORANGE: Warning, actual value out of the alarm limits
> RED: An error has occurred.

1.3.2 Possible Error codes:

»  01283502: pH Setting upper limit / Check the alarm setting.
> 01283503: pH Setting lower limit / Check the alarm setting.

1.4 p02
1.4.1 Color status:

> GREEN: pO: control is working normally.

> ORANGE: Warning, actual value out of the alarm limits

> RED: An error has occurred.

> OFF: DO sensor cable is not connected.

1.4.2 Possible Error codes:

» 01072915: Dissolved Oxygen (DO) Sensor disconnected / Check DO probe and cable.
»  01073502: Dissolved Oxygen (DO) Setting upper limit / Check the alarm setting.

»  01073503: Dissolved Oxygen (DO) Setting lower limit / Check the alarm setting.

1.5 Level

1.5.1 Color status:

> GREEN: Level is normal

> RED: Level (max.) is reached

> OFF: Foam & Level sensor box is not connected.

1.5.2 Possible Error codes:

> 01172915: Level Sensor disconnected / Check the cable connection to the control unit.
> 01172906: Level Sensor set value exceeded / Liquid has been detected by the sensor.

1.6 Foam

1.6.1 Color status:

> GREEN: Foaming is normal, within the detection area.

> RED: Foam has been detected.

> OFF: Foam & Level sensor box is not connected.

1.6.2 Possible Error codes:

> 01132915: Foam Sensor disconnected / Check the cable connection to the control unit.
> 01132906: Foam Sensor set value exceeded / Foam has been detected by the sensor.
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2. Interrupting Status
2.1 Emergency mode display
> All 6 LEDs keep flashing in “RED”

IKA HABITAT

safe

Stirrer Temp pH  pO2 Level Foam

IKA HABITAT -~
%S

Stirrer Temp pH pO2 Level Foam

2.2 WI-Fi® reset and initialization display

2.21 Triple LED (left -right) are flashing in "GREEN" during Wi-Fi® module reset and connection
setup

2.22 Setup finished. Ready for Wi-Fi® connection.

IKA HABITAT

Stirrer Temp pH  pO:2 Level Foam

IKA HABITAT

Stirrer Temp pH pO:2 Level Foam

IKA HABITAT

Stirrer Temp pH  pO:2 Level Foam

Technical data

Environment

Permissible ambient temperature

+5..+40°C

Permissible relative humidity

80% (up to 31 °C), decreasing linearly to max. 50 (@40 °C)

Permitted on-time 100 %
Protection class |
Contamination level 2

Overvoltage category Il

Operation at a terrestrial altitude max. 2000 m
Control unit

Nominal voltage 100 ... 240 VAC
Frequency 50/60 Hz
Max. rated power 1100W
Nominal input power 300 W

Fuse

2xT5.0 A250 V

Dimensions (W x D x H)

224 x 405 x 624 mm

Dimension (W x D)

189 x 345 mm

Material of housing

Metal housing and PUR coated

Weight

14 kg

Protection class according to DIN EN 60529

IP20

Motor direct coupling

0.25L glass 1....2000 rpm
0.5 L glass 1...1400 rpm
1 Lglass: 1...2000 rpm
2 Lglass: 1...2200 rpm
5Laglass: 1... 1500 rpm
10 Lglass: 1 ... 800 rpm
3.0LSU: 1...400 rpm

System requirement

Window 10 or higher
i0S 7 or higher

Interface

UsB

PC connect

RS 232

Ethernet

SU connect

Thermostat

Ext. pump

Ext. signal input 4 ... 20 mA

129



130

Pump Module

Vessel information

Quantity 4 PC

Controller Variable speed (CW / CCW)
ID0.5mm: 0.3 ... 4 c¢min
ID 0.8 mm: 1.0 ... 12 c¢/min
ID 1.2 mm: 1.6 ... 20 c¢/min

Flow rate

(Tube wall thickness 1.6 mm)

ID 1.6 mm: 3.0 ... 45 c¢/min
ID 2.4 mm: 7.0 ... 85 c¢/min
ID 3.2 mm: 13.3 ... 140 c¢min
ID 4.8 mm: 26.6 ... 270 c/min

Probe and controllers

* is optional

Temperature

0...100 °C
Display resolution: 0.1 °C

DO probe (Brand Hamilton)

Range 0 ... 200 %
Display resolution: 0.01 %

pH probe (Brand Hamilton)

Range O ... 14 pH
Display resolution: 0.01 pH

Foam Display: Norm. or Act.
Level Display: Norm. or Act.
o Range 0 ... 100 %

: Display resolution: 0.01 %
. . Range 0.2 ... 400 ms/cm
Conductivity Accuracy + 5%
“Turbidity Range 0 ... 250 g/L

Range 10 ... 4000 FTU

Aeration Module

Gas inlet

- Dry and oil free gases
- Maximum pressure 3.0 barg £10 %

Gas outlet

- Maximum pressure 1.0 barg
With safety relief valve 1.0 bar

Glass Glass Glass Glass Glass Glass
Unit vessel vessel vessel vessel vessel vessel
0.25L 05L 1L 2L 5L 0L
Total volume | 0.4 0.8 1.6 3.00 6.7 12.9
Max. working volume | 0.25 0.5 1 2 5 10
. . 0.06-
Min. working volume | 0.08 0.25 0.30 0.60 1.0 2.0
Vessel inner diameter dv mm 65.6 90 110 130 160 190
Vessel height h mm 130 150 190 260 370 470
Ratio h/dy mm 1.98 1.67 1.73 2.00 2.31 2.47
Liquid height ht mm 78 85 110 160 265 370
Ratio hi/dy mm 1.19 0.94 1.0 1.23 1.66 1.95
Diameter 6-blade impeller dis mm 24 33 40 48 57 68
Plameter 3-pitch blade i 25 34 1 49 9 69
impeller dis
Ratio dis / dv (6-blade) mm 0.37 0.37 0.36 0.37 0.36 0.36
Ratio di / dv (3-pitch blade) mm 0.38 0.38 0.37 0.38 0.37 0.36
Net weight assembled
without media & accessories kg 5.98 6.4 7.87 9.11 13.29 -
single wall
Net weight assembled
without media & accessories kg 6.21 6.77 8.09 10.55 15.66 21.9
double wall
Weight SU 2 L without K . . . B
holder 9
Weight SU 2 L with holder kg - - - - - -

Four gases system (Air, Oz, N> & CO) for Cell culture

Automatic aeration control

Cell culture flow rate

10 ... 2000 cc/min

Fermentation flow rate

100 ... 20000 cc/min

Accuracy

+2% full scale

Temp control module in side vessel

Using heating jacket (single wall vessel)

Room temp ... 60 °C

Using chiller (double wall vessel)

5..80°C

LED light panel

Type

Flexible LED panel system, able to adjust brightness

Number of light panel

Upto 4

Day & night simulation can be programmed
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Overall dimension (mm) Space requirement for autoclaving (mm)

Vessel size Width Depth Height Vessel size Width Depth Height
Glass vessel 0.25 L 875 530 510 Glass vessel 0.25 L 185 215 510
Glass vessel 0.5 L 875 530 630 Glass vessel 0.5 L 185 215 455
Glass vessel 1L 900 530 630 Glass vessel 1L 210 240 505
Glass vessel 2 L 920 530 630 Glass vessel 2 L 230 260 580 (cell ) |480 (ferment)
Glass vessel 5 L 950 530 860 Glass vessel 5 L 260 290 560
Glass vessel 10 L 990 530 980 Glass vessel 10 L 300 330 650

N
Height

Thermostat
Depth

-
I

Y

Width Depth
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Multiuse vessel

Material

Peltier Cooling

Vessel

Borosilicate glass 3.3

Type of cooling

peltier or water cooling

Components contact to medium

Stainless steel 316

Temperature min. / Condenser with Peltier

15 °C

Components not contact to medium

Stainless steel 304

Operating mode

continuous operation

Gasket

EPDM

Auto restart after power failure

yes

O-ring

Silicone USP class VI

Dimensions (W x D x H)

90 x 250 x 70 mm

Hose for peristaltic pump

Weight

2kg

Material

Silicone USP Class VI

Permissible ambient temperature

+5...+40°C

Size (ID x wall THK)

3.2x 1.6 mm

Permissible ambient conditions

80% (up to 31 °C), decreasing linearly to max. 50% (@40 °C)

Tube for air / gases

Protection class according to

Material Silicone tube USP class VI
Size (ID x OD) 3.2x6.4mm

Impeller type

Type 6-blades or 3-pitched blades

DIN EN 60529 P20
Voltage 100 ... 240V
Frequency 50/60 Hz
Power input 50 W

Power input max. 60 W

Flow characteristic

Down or up flow

Fuse

2 xT5.0A 250V

Sparger type

Micro sparger

5 micron

Ring sparger

Hole diameter 0.5 mm

Air pump

Specification

Voltage 115 ... 230 VAC
Rated pressure 0.15 bar
Flow rate 80 Liter / min
Noise level 40 dB
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PC requirements

Minimum

Recommended

Operating system

Windows 10, 32/64 bits

Windows 10, 64 bits

Processor

Intel® Core i3 8th generation (8109U) or
above

Intel® Core i5 4th generation ( or an equi-
valent AMD processor)

Graphics card

Video adapter compatible with DirectX 9,
WDDM driver support and minimum 128
MB RAM

Video adapter compatible with DirectX
10, WDDM driver support and minimum
1 GB RAM

RAM 4GB 8 GB

Storage HDD, minimum 15 GB free disk space SSD, minimum 50 GB free disk space
Display 1024 x 768 (XGA) 1920 x 1080 (FHD)

Peripherals

Ethernet 10BASE-T Gigabit Ethernet

Wi-Fi® 802.11a/b/g/n/ac 802.11a/b/g/n/ac

WPAN 4.2 4.2

UsB USB 2.0 USB 3.0

Serial port (optional)

DB-9 connector

DB-9 connector

Tablet requirements

Minimum

Recommended

Operating system

Running iOS 11 or later

Running iOS 12 or later

Processor ARM: ARMV7-A or higher ARM: ARMV8-A or higher

RAM 2GB 4GB

Storage 32 GB 64 GB

Display 7 inch in diagonal, viewport > 768 x 1024 182‘:Ch in diagonal, viewport = 768 x
Peripherals

Wi-Fi® 802.11a/b/g/n/ac 802.11a/b/g/n/ac

WPAN 4.2 4.2

Smart Phone requirements

Minimum

Recommended

Operating system

Running iOS 11 or later

Running iOS 12 or later

Processor ARM: ARMV7-A or higher ARM: ARMV8-A or higher

RAM 2 GB 4GB

Storage 32 GB 64 GB

Display 5.5 inch in diagonal, viewport > 380 x 640 3302 inch in diagonal, viewport = 412 x
Peripherals

Wi-Fi® 802.11a/b/g/n/ac 802.11a/b/g/n/ac

WPAN 4.2 4.2

Subject to technical changes!

Warranty

> In accordance with IKA Terms and Conditions of Sale, the warranty period is 24 months. For
claims under the warranty please contact your local dealer. You may also send the device
direct to our factory, enclosing the delivery invoice and giving reasons for the claim. You will
be liable for freight costs.

» The warranty does not cover worn out parts, glassware or sensors, nor does it apply to faults
resulting from improper use, insufficient care or maintenance not carried out in accordance
with the instructions in this operating manual.
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Phone: +48 22 201 99 79
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Phone: +44 1865 986 162
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TURKEY
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Phone: +90 216 394 43 43
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